Communications & Safety Regulation Information

Compliance Statement
The model 003 and 003 Rack comply with the following standards regulating interference and EMC:

- FCC Part 15 Class B
- EN55022
- EN55024
- AS/NZS 3548 Class B
- CISPR 22 Class B

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:

- Reorient or locate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Digidesign, could void the user’s authority to operate the equipment.

Canadian Compliance Statement:
This Class B digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada

Australian Compliance

CE Compliance Statement:
Digidesign is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 89/336/EEC and Low Voltage Directive 73/23/EEC.
Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th / IEC 60065 7th and Canadian CAN/CSA C22.2 60065:03. Digidesign Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
11) Only use attachments/accessories specified by the manufacturer.
12) Unplug this apparatus during lightning storms or when unused for long periods of time.
13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
Chapter 5. Launching and Configuring Pro Tools LE ........................................ 23
    Starting Up or Shutting Down Your System ........................................ 23
    Launching Pro Tools LE .................................................................... 24
    Configuring Pro Tools LE ............................................................... 24

Chapter 6. 003 Top Panel ........................................................................ 31
    003 Operating Modes ...................................................................... 31
    003 Top Panel Overview ................................................................. 33
    Display Section ........................................................................... 34
    Fader Section ................................................................................ 36
    Console/Channel View Section ....................................................... 41
    Transport and Navigation Controls ............................................... 44
    Automation Section ...................................................................... 48
    Modifiers Section ......................................................................... 48
    Mic/DI Input Controls ................................................................. 49
    Monitor Section ............................................................................ 50

Chapter 7. 003 Rack Front Panel ............................................................... 51
    Mic/DI Input Controls .................................................................. 52
    Monitor Section ............................................................................ 52
    Status Indicators ......................................................................... 53

Chapter 8. 003 and 003 Rack Back Panels .............................................. 55

Chapter 9. Making Studio Connections .................................................. 61
    Getting Sound In and Out of Your 003 or 003 Rack ...................... 61
    Connecting a Microphone ............................................................... 63
    Connecting Instruments to 003 or 003 Rack ................................ 65
    Connecting Equipment with Digital Ins and Outs ......................... 67
    Word Clock .................................................................................. 68
    Using External Effects Devices ...................................................... 69
    Monitoring and Recording from Alternate Sources ..................... 70
    Recording from a Digital Device .................................................... 71
    Connecting a Recorder for Mixdowns ............................................ 72
    MIDI Connections ........................................................................ 72
<table>
<thead>
<tr>
<th>Chapter 10. Common Tasks with Pro Tools LE</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording a Pro Tools Session</td>
<td>75</td>
</tr>
<tr>
<td>Importing Audio from a CD</td>
<td>77</td>
</tr>
<tr>
<td>Creating an Audio CD from a Pro Tools Session</td>
<td>78</td>
</tr>
<tr>
<td>Recording MIDI in a Pro Tools Session</td>
<td>80</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11. Pro Tools Mode with 003</th>
<th>83</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving a Session</td>
<td>83</td>
</tr>
<tr>
<td>Working in Console View</td>
<td>84</td>
</tr>
<tr>
<td>Working in Channel View</td>
<td>87</td>
</tr>
<tr>
<td>Display Options in Console and Channel View</td>
<td>90</td>
</tr>
<tr>
<td>Navigating and Editing Values in Entry Fields</td>
<td>91</td>
</tr>
<tr>
<td>Working with Tracks</td>
<td>91</td>
</tr>
<tr>
<td>Assigning Pro Tools Paths (Input, Output, Sends, Inserts)</td>
<td>92</td>
</tr>
<tr>
<td>Working with Output Windows</td>
<td>95</td>
</tr>
<tr>
<td>Recording</td>
<td>96</td>
</tr>
<tr>
<td>Navigating in the Edit Window</td>
<td>96</td>
</tr>
<tr>
<td>General Editing</td>
<td>97</td>
</tr>
<tr>
<td>Working With Memory Locations</td>
<td>98</td>
</tr>
<tr>
<td>Controlling Track Display on the Control Surface</td>
<td>98</td>
</tr>
<tr>
<td>Working with Automation</td>
<td>100</td>
</tr>
<tr>
<td>003 Top Panel Shortcuts</td>
<td>101</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix A. Configuring MIDI Studio Setup (Windows Only)</th>
<th>105</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Studio Setup</td>
<td>105</td>
</tr>
<tr>
<td>MIDI Patch Name Support</td>
<td>107</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix B. Configuring AMS (Mac OS X Only)</th>
<th>109</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio MIDI Setup</td>
<td>109</td>
</tr>
<tr>
<td>Patch Name Support</td>
<td>112</td>
</tr>
</tbody>
</table>
Appendix C. Utility Mode (003 Only) .......................................................... 113
 Accessing Utility Mode ................................................................. 113
 Viewing Firmware Version Data ................................................... 114
 LCD Display Test ........................................................................ 114
 LED Tests .................................................................................... 114
 Switch Test ................................................................................. 115
 Encoder Test ............................................................................... 115
 Fader Tests ................................................................................. 115
 Vegas Mode ................................................................................. 116
 MIDI Test ..................................................................................... 117
 Audio Test ................................................................................... 117

Appendix D. Hard Drive Configuration and Maintenance ..................... 119
 Avoid Recording to the System Drive ............................................. 119
 Supported Drive Formats and Drive Types. .................................. 119
 Formatting an Audio Drive ............................................................ 120
 Partitioning Drives .................................................................... 122
 Defragmenting an Audio Drive ..................................................... 123
 Using Mac Drives on Windows Systems ....................................... 124
 Hard Disk Storage Space .............................................................. 125

Appendix E. Troubleshooting ............................................................... 127
 Backing Up Your Work ................................................................ 127
 Common Issues .......................................................................... 127
 Performance Factors .................................................................. 128
 Before You Call Digidesign Technical Support ............................... 128

Index ............................................................................................ 131
Installation QuickStart

Windows Installation Overview
(Windows Systems Only)

Installing 003™ or 003 Rack on a Windows computer includes the following steps:

2 “Connecting 003 or 003 Rack to the Computer” on page 12.

⚠️ When connecting 003 or 003 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.

3 “Installing Pro Tools LE” on page 14.
4 Launching Pro Tools LE. (See Chapter 5, “Launching and Configuring Pro Tools LE.”)

💡 Your authorization code is located on the inside cover of this guide.

5 Making audio and MIDI connections to 003 or 003 Rack. (See Chapter 9, “Making Studio Connections.”)

Mac Installation Overview
(Mac OS X Systems Only)

Installing 003 or 003 Rack on a Mac includes the following steps:

1 “Mac System Optimization” on page 17.
2 “Installing Pro Tools LE” on page 19.
3 “Connecting 003 or 003 Rack to the Computer” on page 21.

⚠️ When connecting 003 or 003 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.

4 Launching Pro Tools LE. (See Chapter 5, “Launching and Configuring Pro Tools LE.”)

💡 Your authorization code is located on the inside cover of this guide.

5 Making audio and MIDI connections to 003 or 003 Rack. (See Chapter 9, “Making Studio Connections.”)
Welcome to 003™ and 003 Rack, Digidesign’s cross-platform Pro Tools® workstations for music, sound design, and multimedia production.

003 and 003 Rack Packages

The 003 and 003 Rack packages include the following:

- 003 or 003 Rack unit
- Pro Tools Installer disc containing Pro Tools LE™ software and included Digi-Rack RTAS® (Real-Time AudioSuite™) and AudioSuite plug-ins, optional plug-ins which can be purchased, and electronic PDF guides
- This Getting Started Guide, covering installation, configuration, and common tasks for your Pro Tools system
- FireWire cable, 6-pin to 6-pin, for connecting 003 or 003 Rack to a computer
- AC power cable
- Digidesign Registration Information Card

003 and 003 Rack Features

Audio and MIDI Features

The 003 and 003 Rack units provide the following input and output capacity:

- Up to 18 channels of I/O
- 8 analog audio inputs (4 with mic preamps), with A/D converters supporting up to 24-bit, 96 kHz audio:
  - 48V phantom power on mic preamps, switchable in channel pairs.
  - HPF (High-Pass Filter) switches for filtering out rumbles or AC hum below 75 Hz on Inputs 1–4.
- Inputs 5–8 switchable between +4 dBu (for pro-level gear) and –10 dBV (for consumer-level gear).
- Eight analog audio outputs, with D/A converters supporting up to 24-bit, 96 kHz audio.
- Main and Alternate Monitor Output pairs (+4 dBV) with a single level control. These outputs mirror Outputs 1–2 and provide direct connection to a monitoring system (such as a stereo power amp, powered speakers, or another stereo destination).
- Aux Input pair (+4 dBu) for direct monitoring of tape or CD input sources.
- Two 1/4-inch stereo headphone outputs (Headphone 1 and 2) with level controls. Headphone 2 can monitor Main Outputs 1–2 like Headphone 1, or be switched to monitor Outputs 3–4 for a discrete cue mix.
- Optical connectors for 8 channels of Optical (ADAT) I/O (supporting up to 48 kHz) or 2 channels of Optical S/PDIF I/O.
- RCA connectors for 2 channels of S/PDIF digital I/O supporting up to 24-bit, 96 kHz audio.
- Word Clock In and Out ports, to receive or send 1x Word clock.
- 1 MIDI In port and 2 MIDI Out ports, providing up to 16 channels of MIDI input and up to 32 channels of MIDI output.
- Footswitch jack for punching in and out while recording.
- Monitor section with Mute switch and switches for routing input and output signals.

**Control Surface Features**

*(003 Only)*

003 provides an integrated control surface that includes the following:

- Eight motorized touch-sensitive faders for controlling track volume and other parameters. Includes ability to disable faders during playback of automated mixes.
- Dedicated Solo, Mute and Channel Select/Record Arm switches.
- Eight multifunction rotary encoders for operating pan, send, and plug-in controls.
- Fast and convenient access to sends, inserts, plug-in pages, pan settings, and other track functions.
- Automation Mode switches for selecting and displaying Automation modes.
- Large, bright LCD for data display.
- Transport controls, plus Transport mode switches for loop playback, loop record, and QuickPunch.
- Dual-concentric Jog/Shuttle wheel.
- Save, Undo, and Enter switches. Memory Location switch for recalling Memory Locations or opening the Memory Location window.
- Windows switches for Pro Tools display of plug-in, Mix, and Edit windows.
- Navigation and Zoom controls.
- MIDI mode switches for MIDI mapping.
- Utility mode switch for testing 003.
Pro Tools LE Capabilities

Pro Tools LE™ on Windows or Mac provides the following capabilities with 003 and 003 Rack:

- Playback of up to 32 mono (or 16 stereo) digital audio tracks, or a combination of playback and recording up to 32 mono (or 16 stereo) digital audio tracks, depending on your computer’s capabilities
- Up to 128 audio tracks (with 32 voiceable tracks maximum), 128 Auxiliary Input tracks, 64 Master Fader tracks, 256 MIDI tracks, and 32 Instrument tracks per session
- 16-bit or 24-bit audio resolution, at sample rates up to 96 kHz
- Non-destructive, random-access editing and mix automation
- Audio processing with up to 5 RTAS plug-in inserts per track, depending on your computer’s capabilities
- Up to 5 hardware inserts per track
- Up to 10 sends per track
- Up to 32 internal mix busses

⚠️ Pro Tools LE uses your computer’s CPU to mix and process audio tracks (host processing). Computers with faster clock speeds yield higher track counts and more plug-in processing.

System Requirements

003 and 003 Rack can be used with a Digidesign-qualified Windows or Mac computer running Pro Tools LE software.

For complete system requirements, visit the Digidesign website (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For a list of Digidesign-qualified computers, operating systems, MIDI interfaces, hard drives, and third-party devices, visit the Digidesign website (www.digidesign.com).

MIDI Requirements

003 and 003 Rack include one MIDI In port and two MIDI Out ports, providing 16 channels of MIDI input and 32 channels of MIDI output.

If you require additional MIDI ports, add a MIDI interface (such as a Digidesign MIDI I/O) to your system.
Hard Drive Requirements

For optimal audio recording and playback, all Pro Tools systems require one or more Digidesign-qualified drives. This is a separate physical drive from your internal system drive, and needs to meet the specifications listed on our website.

For a list of qualified hard drives, visit the Digidesign website (www.digidesign.com).

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with Windows Disk Management (Windows) or the Disk Utility application included with Apple System software (Mac).

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

Digidesign does not recommend recording to the system drive. Record to a system drive only when necessary.

Digidesign Registration

Review the enclosed Digidesign Registration Information Card and follow the instructions on it to quickly register your purchase online. Registering your purchase is the only way you can be eligible to receive complimentary technical support and future upgrade offers. It is one of the most important steps you can take as a new user.

About the Pro Tools Guides

This Getting Started guide explains how to install Pro Tools LE software, make basic connections to your 003 or 003 Rack interface (to get sound in and out of your interface), and do common tasks (such as recording in Pro Tools).

In addition to any printed guides or documentation included with your system, PDF versions of Pro Tools guides and readmes are installed automatically with Pro Tools.

The main guides (such as the Pro Tools Reference Guide and the Pro Tools Menus Guide) are accessible from the Pro Tools Help menu.

- **Pro Tools Menus Guide** covers all the Pro Tools on-screen menus.
- **DigiRack Plug-Ins Guide** explains how to use the RTAS and AudioSuite plug-ins included with Pro Tools.
- **Digidesign Plug-Ins Guide** explains how to use optional Digidesign plug-ins.
- **Pro Tools Shortcuts** lists keyboard and Right-click shortcuts for Pro Tools.

These guides and other guides are installed on your startup drive during installation. To view or print PDF guides, you can use Adobe Reader or Apple Preview (Mac only).

Printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the DigiStore (www.digidesign.com).
Conventions Used in This Guide

Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

🔍 Shortcuts show you useful keyboard or mouse shortcuts.

🔍 Cross References point to related sections in this guide and other Digidesign guides.

About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Registration Register your purchase online. See the enclosed Digidesign Registration Information Card for instructions.

Support Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; join the worldwide Pro Tools community on the Digidesign User Conference.

Training and Education Become a certified Pro Tools Operator or Expert; study on your own using courses available online, or find out how you can learn in a classroom setting at a certified Pro Tools Training Center.

Products and Developers Learn about Digidesign products; download demo software; learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Digidesign; sign up for a Pro Tools demo.

To learn more about these and other resources available from Digidesign, visit the Digidesign website (www.digidesign.com).
Windows System Optimization

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

Required Optimizations

To ensure optimum performance with Pro Tools LE, configure the following settings before you install Pro Tools hardware and software.

⚠️ When you are finished changing Windows system settings, restart your computer.

Enabling DMA

Enabling your computer’s DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows XP detects and activates DMA mode by default.

To enable DMA for any IDE hard drives:

1. Choose Start > Control Panel.
2. In Classic View, launch System.
3. Click the Hardware tab.
Under Device Manager, choose Device Manager.

5 In the Device Manager window, double-click IDE ATA/ATAPI controllers, then double-click the Primary IDE Channel for your IDE hard drive.

6 Click the Advanced Settings tab.

7 For each device, set the Transfer Mode to "DMA if available," and click OK.

8 Repeat steps 5–7 for any additional IDE Channels.

9 Close the Computer Management window.

Disabling System Standby and Power Management

When using Pro Tools, the Windows System Standby power scheme must be set to Always On. This helps prevent long record or playback passes from stopping due to system resources powering down.

To configure Windows Power Management:
1 Choose Start > Control Panel.
2 Double-click Power Options.
3 Click the Power Schemes tab.
4 From the Power Schemes pop-up menu, select Always On.
5 Click OK.

This sets System Standby, System Hibernate, and “Turn off hard disks” to Never.

Disabling ClearType Font Smoothing

When using Pro Tools, the Effects “Clear Type” setting must be disabled.

To disable ClearType font smoothing:
1 Choose Start > Control Panel.
2 Double-click Display.
3 Click the Appearance tab.
4 Click Effects.
5 Deselect “Use the following method to smooth edges of screen fonts.”
6 Click OK to save your settings and close the Effects dialog.
7 Click OK.
8 Restart the computer.

Recommended Optimizations

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:

• Avoid running any unneeded programs at the same time as Pro Tools.
• Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
• Turn off any non-essential USB devices while running Pro Tools.
• If your video display card supports it, enable Bus Mastering in the manufacturer’s Control Panel. See the manufacturer’s instructions for details.

On AMD processors, be sure to check and disable Cool N’Quiet in the System BIOS (in the Cool & Quiet Configuration section). See the manufacturer’s documentation for instructions on disabling this power option, if necessary.
Optional Optimizations

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

Disabling Network Cards

If applicable, disable any networking cards (other than a FireWire card, if you are using one to connect 003 or 003 Rack or any FireWire drives to your system).

To disable a network card:
1. Right-click My Computer and choose Manage.
2. Under System Tools, select Device Manager.
3. In the Device Manager window, double-click Network adapters, then double-click the Network Adapter card you want to disable.
4. Under the General tab, choose “Do not use this device (disable)” from the Device Usage pop-up menu, and click OK.
5. Close the Computer Management window.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:
1. Choose Start > Control Panel.
2. In Classic View, double-click System.
3. Click the Advanced tab.
4. Under the Performance section, click the Settings button.
5. In the Performance Options window, click the Advanced tab.
6. Under the Processor Scheduling section, select the Background Services option.
7. Under the Memory Usage section, select the System cache option.
8. Click OK to close the Performance Options window.
9. Click OK to close the System Properties window.
10. Restart the computer for the changes to take effect.

Disabling Hyper-Threading

When working with RTAS plug-ins, Pro Tools takes advantage of the added processing power of computers that have multiple processors, or that feature multi-core processing or Hyper-Threading.

However, if you set the number of processors available for RTAS processing to 1 (in the Pro Tools Playback Engine dialog), some computers with Hyper-Threading capability may experience decreased performance.

If this occurs, you can increase the number of RTAS processors in the Playback Engine dialog, or you can disable Hyper-Threading on the computer.

See your computer’s documentation for steps on how to enter the computer’s BIOS and disable Hyper-Threading.
Disabling System Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

To Disable System Startup Items:

1. From the Start menu, choose Run.
2. Type “msconfig” and click OK. The System Configuration Utility opens.
3. Under the General tab, choose Selective Startup.
4. Deselect Load Startup Items and click OK.
5. Click Restart to restart the computer.
6. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the “Don’t show this message again” option. If performance has not changed, run “msconfig” and return your computer Selective Startup back to Normal Startup. Alternatively, try disabling Startup items and non-essential processes individually.

Connecting 003 or 003 Rack to the Computer

Before installing Pro Tools LE software, you need to connect 003 or 003 Rack to the computer.

⚠️ When connecting 003 or 003 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.

To connect 003 or 003 Rack to your computer:

1. Plug 003 or 003 Rack into a standard AC receptacle, using the AC power cable included with the unit. AC power is required to operate 003 and 003 Rack.
2. Locate the FireWire cable that came with your unit.
3. Be sure to note the orientation of the FireWire cable connector when you insert it in your 003 or 003 Rack. It is possible to damage the FireWire port if you force the connector in upside down.

If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “4-Pin FireWire Cable” on page 13 for FireWire cable information.

3. Plug one end of the FireWire cable into one of the ports marked “1394” on the back panel of the 003 or 003 Rack. Either port will work.

⚠️ If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “4-Pin FireWire Cable” on page 13 for FireWire cable information.

003 and 003 Rack FireWire ports (back panel)
Do one of the following, depending on your system configuration:

- Plug the other end of the FireWire cable into an available FireWire port on your computer.

- or -

- If your computer has only one FireWire port, plug the other end of the FireWire cable into an available FireWire port on a FireWire hard drive connected to your computer.

⚠️ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCM-CIA/ExpressCard FireWire options, visit the Digidesign website (www.digidesign.com).

4-Pin FireWire Cable

003 and 003 Rack include a 6-pin to 6-pin FireWire cable. Some Windows laptops include only a 4-pin FireWire port (commonly labeled “1394”). To use 003 or 003 Rack with these computers, a 4-pin to 6-pin cable is required. Purchase this cable (part number #9940-30779-00) through your authorized Digidesign dealer or online through the DigiStore (www.digidesign.com).

⚠️ This cable can also be purchased at computer supply stores. Maximum supported cable length for FireWire (IEEE-1394) is 14 feet (4.3 meters).

Connecting FireWire Drives

Connect FireWire hard drives directly to a FireWire port on your computer.

⚠️ Do not connect a FireWire hard drive to the second FireWire port on the back panel of 003 or 003 Rack.

The FireWire ports on 003 and 003 Rack do not pass audio data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to 003 or 003 Rack. This will prevent hard drive errors and data loss in case 003 or 003 Rack is powered off.

To connect a FireWire hard drive, do one of the following:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on the computer, and connect 003 or 003 Rack to another FireWire port on the computer.

- or -

- If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect 003 or 003 Rack to an available FireWire port on the drive.

⚠️ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCM-CIA/ExpressCard FireWire options, visit the Digidesign website (www.digidesign.com).
Connecting Other FireWire Devices to 003 or 003 Rack

The second FireWire port on 003 or 003 Rack is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 and 003 Rack supply power from the computer through its FireWire ports, letting you recharge batteries in connected FireWire devices.

Installing Pro Tools LE

To install Pro Tools LE:

1. Turn on unit. Press the Power switch on the back panel of the 003 or the front panel of the 003 Rack. After a short power-up sequence, the Monitor Mute switch illuminates to indicate the unit is on.

   **Warning:** Do not disconnect the FireWire connection to 003 or 003 Rack while the unit is powered on. Connecting and disconnecting the FireWire cable after the unit is powered up can cause errors and may damage the unit. Be sure to power down all components of the system before disconnecting them.

2. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, see your Windows documentation.


4. Insert the Pro Tools Installer disc for Windows in your DVD drive.

5. On the Installer disc, locate and open the Pro Tools Installer folder.

6. Double-click the Setup icon.

7. Follow the on-screen instructions to proceed with installation.

8. Select the install location. For maximum reliability, install Pro Tools on your startup drive.

9. Click Next.

10. Select the Pro Tools application for installation.

11. You can also select from a list of optional items to install along with Pro Tools.

**Mac HFS+ Disk Support Option** This option lets your Pro Tools system read, write, record, and playback using Mac-formatted HFS+ disks. HFS+ disks are commonly referred to as Mac OS Extended disks.

**DigiTranslator** DigiTranslator™ is a software option for Pro Tools that lets you convert and exchange OMF and AAF sequences and MXF files directly in the Pro Tools application. This option is purchased separately.

**Command|8 Controller and Driver** The Command|8 Driver is required if you are using the Digidesign Command|8 control surface.

**MP3 Export Option** The MP3 Export Option lets you export MP3 files from Pro Tools. This option is purchased separately.

12. Click Next.

13. Click Install.

**Warning:** Windows will display several messages during installation that can be ignored, including multiple “Found New Hardware” dialogs and “A Problem Occurred During Hardware Installation.”

**Warning:** If you get a warning dialog about the driver not passing Windows Logo testing, click Continue Anyway.
14 Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

15 When installation is complete, click Finish.

Installing QuickTime

A Digidesign-qualified version of QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows XP is available as a free download from the Apple website (www.apple.com).

⚠️ For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of the Digidesign website (www.digidesign.com).

To install QuickTime:

1 Visit www.apple.com and go to the QuickTime page.

2 Download the QuickTime installer application to your computer.

3 Double-click the QuickTime installer application and follow the on-screen installation instructions.

4 Restart your computer.

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including audio drivers (for playing other audio applications through your Digidesign hardware) and a Pro Tools demo session.

Additional plug-in installers on the disc are paid options. You can download trial activations of these plug-ins from the Digidesign website (www.digidesign.com) if you have an iLok USB Smart Key and iLok.com account.

Windows Audio Drivers

The Digidesign ASIO Driver and WaveDriver Windows System Audio Driver let you use your 003 or 003 Rack hardware interface with third-party applications that support the ASIO Driver or WaveDriver MME (Multimedia Extension).

The Digidesign ASIO Driver and WaveDriver for 003 and 003 Rack are automatically installed when you install Pro Tools.

Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Output) Driver is a single-client multichannel sound driver that allows third-party audio programs that support the ASIO standard to record and play back through Digidesign hardware.

⚠️ For detailed information on configuring the Digidesign ASIO Driver, see the Windows Audio Drivers Guide.
Digidesign WaveDriver

The Digidesign WaveDriver Windows System Audio Driver is a single-client, stereo sound driver that allows third-party audio programs that support the WaveDriver MME (Multimedia Extension) standard to play back through Digidesign hardware.

For detailed information on configuring the Digidesign WaveDriver, see the Windows Audio Drivers Guide.

Standalone Digidesign ASIO Driver

Digidesign Windows Audio Drivers can be installed on Windows systems that do not have Pro Tools software installed. Use the standalone version of the Digidesign Windows Audio Drivers installer (Digidesign Audio Drivers Setup.exe), which is available on the Pro Tools Installer disc.

For information on installing and configuring the standalone version of the Digidesign Windows Audio Drivers, see the Windows Audio Drivers Guide.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo session that you can use to verify that your system is working.

Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 120.

To install the demo session:

1 Insert the Pro Tools LE Installer disc into your DVD drive.

2 From your DVD drive, locate and open the Additional Files/Pro Tools LE Demo Session Installer folder.

3 Double-click Setup.exe.

4 Select your audio drive as the install location and click Install.

5 When installation is complete, click OK.

Removing Pro Tools LE

If you need to remove Pro Tools LE software from your computer, you can use the Add or Remove Programs command.

To remove Pro Tools from your computer:

1 Choose Start > Control Panel.

2 Double-click Add or Remove Programs.

3 From the Currently Installed Programs list, select Digidesign Pro Tools LE.

4 Click the Change/Remove button.

5 Follow the on-screen instructions to remove Pro Tools LE.
This chapter contains information for Mac systems only. If you are installing Pro Tools on a Windows computer, see Chapter 3, “Windows Configuration.”

⚠️ Before installing this version of Pro Tools, see the Read Me information included on the Pro Tools Installer disc.

### Mac System Optimization

To ensure optimum performance with Pro Tools LE, configure your computer before installing Pro Tools software.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

⚠️ Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, see the latest compatibility information on the Digidesign website (www.digidesign.com).

### Installation Overview

Installing 003 or 003 Rack on a Mac includes the following steps:

1. “Mac System Optimization” on page 17.
3. “Connecting 003 or 003 Rack to the Computer” on page 21.
4. Launching Pro Tools LE. (See Chapter 5, “Launching and Configuring Pro Tools LE.”)
5. Making audio and MIDI connections to 003 or 003 Rack. (See Chapter 9, “Making Studio Connections.”)

⚠️ When connecting 003 or 003 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.
**Turning Off Software Update**

**To turn off the Software Update feature:**

1. Choose System Preferences from the Apple menu and click Software Update.
2. Click Update Software and deselect Check for Updates.

**Turning Off Energy Saver**

**To turn off the Energy Saver feature:**

1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click Sleep and do the following:
   - Set the computer sleep setting to Never.
   - Set the display sleep setting to Never.
   - Deselect “Put the hard disk(s) to sleep when possible” option.

**Setting Processor Performance**

(Mac G5 Computers and G4 Powerbooks Only)

**To set the Processor Performance:**

1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click Options and set Processor Performance to Highest.

**Disabling Spotlight Indexing**

The Mac OS X Spotlight feature indexes files and folders in the background, affecting system performance. It is recommended that you disable Spotlight indexing before using Pro Tools.

> **Disabling Spotlight indexing will cause the Find function in Mac OS X to no longer work. You will no longer be able to search for files on drives set to private.**

**To disable Spotlight indexing:**

1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click Privacy.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

**Disabling the Spotlight Shortcuts**

The Mac OS X Spotlight feature uses the same key commands Pro Tools uses to start recording (Command+Spacebar), and to record online (Command+Option+Spacebar). If you want to retain use of these key commands in Pro Tools, these shortcuts must be disabled.

**To disable the Spotlight keyboard shortcut:**

1. Choose System Preferences from the Apple menu and click Spotlight.
2. Deselect “Spotlight menu keyboard shortcut” and “Spotlight window keyboard shortcut.”

**Disabling the Dashboard Shortcut**

The Mac OS X Dashboard feature uses the same key command Pro Tools uses to start recording (F12). If you want to retain use of this key command in Pro Tools, this shortcut must be disabled.

**To disable the Dashboard keyboard shortcut:**

1. Choose System Preferences from the Apple menu and click Dashboard and Exposé.
2. Set the Dashboard keyboard shortcut to “–” to disable the shortcut.
Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:

1. Launch the Disk Utility application, located in Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Click Enable Journaling in the toolbar.

Installing Pro Tools LE

After the Apple System software settings are configured, you are ready to install Pro Tools LE.

To install Pro Tools LE:

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools.

   For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Insert the Pro Tools LE Installer disc in your DVD drive.
3. On the Installer disc, locate and double-click “Install Pro Tools LE.”
4. Follow the on-screen instructions to proceed with installation.
5. Select the install location. For maximum reliability, install Pro Tools on your startup drive.
6. Click Continue.
7. Select the Pro Tools application for installation.
8. You can also select from a list of optional items to install along with Pro Tools:
   - DigiTranslator DigiTranslator™ is a software option for Pro Tools that lets you convert and exchange OMF and AAF sequences and MXF files directly in the Pro Tools application. This option is purchased separately.
   - MIDI I/O Driver The MIDI I/O Driver is required if you are using the Digidesign MIDI I/O.
   - MP3 Export Option The MP3 Export Option lets you export MP3 files from Pro Tools. This option is purchased separately.
9. Click Install.
10. If prompted, enter your Administrator password and click OK to authenticate the installation.
11. Follow the remaining on-screen instructions.
12. When installation is complete, click Restart.

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including audio drivers for playing other audio applications through your Digidesign hardware and a Pro Tools demo session.

Additional plug-in installers on the disc are paid options. You can download trial activations of these plug-ins from the Digidesign website (www.digidesign.com) if you have an iLok USB Smart Key and iLok.com account.
Digidesign CoreAudio Driver

The Digidesign CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio-compatible applications to record and play back through Digidesign hardware.

⚠️ The Digidesign CoreAudio Driver is multi-client with third party applications only. It cannot be used with other applications when Pro Tools is launched with 003 or 003 Rack.

The CoreAudio Driver is installed by default when you install Pro Tools.

For information on configuring the Digidesign CoreAudio Driver, see the Digidesign CoreAudio Guide.

Standalone CoreAudio Driver

The Digidesign CoreAudio Driver can be installed as a standalone driver on Mac systems that do not have Pro Tools software installed.

⚠️ If Pro Tools was uninstalled, CoreAudio Driver was automatically uninstalled at that time.

The standalone version can be installed using the Pro Tools installer or downloaded from the Digidesign website (www.digidesign.com).

For information on configuring the standalone version of the Digidesign CoreAudio Driver, see the CoreAudio Drivers Guide.

To install the Standalone CoreAudio Driver from the Pro Tools Installer disc:

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, see your Apple Mac OS X documentation.
2. Insert the Pro Tools LE Installer disc in your DVD drive.
3. On the Installer disc, locate and double-click “Install Pro Tools LE.”
4. Follow the on-screen instructions to proceed with installation.
5. Select the install location. For maximum reliability, install Pro Tools on your startup drive.
6. Click Continue.
7. Select the CoreAudio Driver and deselect the Pro Tools application and other options.
8. Click Install.
9. If prompted, enter your Administrator password and click OK to authenticate installation.
10. Follow the remaining on-screen instructions.
11. When installation is complete, click Restart.

Pro Tools Demo Session

The Pro Tools Installer disc includes a separate demo session installer. You can use this session to verify that your system is working.

To install the demo session:

1. Insert the Pro Tools LE Installer disc in your DVD drive. Locate and double-click the demo session installer icon.
2. Select your audio drive as the install location and click Install.
3. When installation is complete, click Quit.
Connecting 003 or 003 Rack to the Computer

After installing Pro Tools LE software, connect 003 or 003 Rack to the computer before launching Pro Tools LE.

To connect 003 or 003 Rack to your computer:
1. If your computer is on, power it down.
2. Plug 003 or 003 Rack into a standard AC receptacle, using the AC power cable included with the unit. AC power is required to operate 003 and 003 Rack.
3. Locate the FireWire cable that came with your unit.
4. Plug one end of the FireWire cable into one of the ports marked “1394” on the back panel of the 003 or 003 Rack. Either port will work.

⚠ Be sure to note the orientation of the FireWire cable connector when you insert it in your 003 or 003 Rack. It is possible to damage the FireWire port if you force the connector in upside down.

5. Do one of the following, depending on your system configuration:
   - Plug the other end of the FireWire cable into an available FireWire port on your computer.
   - or –
   - If your computer has only one FireWire port, plug the other end of the FireWire cable into an available FireWire port on a FireWire hard drive connected to your computer.

⚠ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCM-CIA/ExpressCard FireWire options, visit the Digidesign website (www.digidesign.com).

Connecting FireWire Drives

Connect FireWire hard drives directly to a FireWire port on your computer.

⚠ Do not connect a FireWire hard drive to the second FireWire port on the back panel of 003 or 003 Rack.

The FireWire ports on 003 and 003 Rack do not pass audio data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to 003 or 003 Rack. This will prevent hard drive errors and data loss in case 003 or 003 Rack is powered off.

⚠ To yield higher performance from audio drives, enable journaling. See “Enabling Journaling for Audio Drives” on page 19.
To connect a FireWire hard drive, do one of the following:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on the computer, and connect 003 or 003 Rack to another FireWire port on the computer.

- or -

- If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect 003 or 003 Rack to an available FireWire port on the drive.

⚠ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count.

For information on supported PCI/PCM-CIA/ExpressCard FireWire options, visit the Digidesign website (www.digidesign.com).

Connecting Other FireWire Devices to 003 or 003 Rack

The second FireWire port on 003 or 003 Rack is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 and 003 Rack supply power from the computer through its FireWire ports, letting you recharge batteries in connected FireWire devices.

Removing Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application.

To remove Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click the “Uninstall Pro Tools” file.

3. Click Continue to proceed with the uninstall.

4. Choose the type of uninstall you want to perform:

   - Safe Uninstall Leaves certain plug-ins and system files needed for compatibility with some Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update to a .cs release.

   - Clean Uninstall Removes all Pro Tools files, including system files, Digidesign plug-ins, and MIDI patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot from a clean system.

5. Click Uninstall.

6. Enter your Administrator password and click OK.

7. Click Finish to close the Installer window.
After you have connected your system and installed Pro Tools LE software, you are ready to launch and configure Pro Tools LE.

**Starting Up or Shutting Down Your System**

To ensure that the components of your Pro Tools system communicate properly with each other, you need to start them in a particular order.

**Shut down your Pro Tools system in this order:**

1. Quit Pro Tools and any other running applications.

   *To quit Pro Tools, choose File > Exit (Windows) or Pro Tools > Quit (Mac).*

2. Turn off or lower the volume of all output devices in your system.

3. Turn off your computer.

4. Turn off the 003 or 003 Rack.

5. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.

6. Turn off any external hard drives.

**Start up your Pro Tools system in this order:**

1. Lower the volume of all output devices in your system.

2. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.

3. Turn on any MIDI interfaces, MIDI devices, or synchronization peripherals.

4. Turn on the 003 or 003 Rack.

5. Turn on your computer.

6. Launch Pro Tools or any third-party audio or MIDI applications.

   *For more information on launching Pro Tools, see “Launching Pro Tools LE” on page 24.*
Launching Pro Tools LE

When launching Pro Tools LE the first time, you are prompted to enter an authorization code to validate your software.

To authorize Pro Tools LE software:

1. Make sure 003 or 003 Rack is connected to your computer and powered on.

2. Do one of the following:
   - Double-click the Pro Tools LE shortcut on the desktop (Windows) or click the Pro Tools LE icon in the Dock (Mac).
   - or –
   - Locate and double-click the Pro Tools LE application on your hard drive.

3. Enter the authorization code in the dialog (making sure to type it exactly as printed, and observing any spaces and capitalization), then click Validate.

Your authorization code is located on the inside cover of this guide.

Updating 003 or 003 Rack Firmware

When you launch Pro Tools software, it automatically checks the version of the unit’s firmware, and prompts you to update it if a newer version is available.

If you update your unit’s firmware, let the update complete before disconnecting or turning off your system.

When a firmware update completes, Pro Tools quits, and you must relaunch Pro Tools.

If during the update process you get a message that Pro Tools cannot communicate with 003 or 003 Rack, wait up to 30 seconds for the message to close. If the message does not go away, power off 003 or 003 Rack and then power it on again.

Configuring Pro Tools LE

Pro Tools System Settings

Pro Tools LE lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.
**Hardware Buffer Size**

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins. The H/W Buffer setting can also be used to manage monitoring latency.

- Lower Hardware Buffer Size settings reduce monitoring latency, and are useful when you are recording live input.
- Higher Hardware Buffer Size settings allow for more audio processing and effects, and are useful when you are mixing and using more RTAS plug-ins.

![In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can increase the latency caused by RTAS plug-ins, and affect the accuracy of plug-in automation, mute data, and MIDI track timing.]

**To change the Hardware Buffer Size:**

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.

**RTAS Processors**

The RTAS Processors setting determines the number of processors in your computer allocated for RTAS plug-in processing.

With computers that have multiple processors, or that feature multi-core processing or hyper-threading, this setting lets you enable multi-processor support for RTAS processes. Used in combination with the CPU Usage Limit setting, the RTAS Processors setting lets you control the way RTAS processing and other Pro Tools tasks are carried out by the system.

- A higher number of processors reserves more CPU processing capacity for RTAS plug-in processing. This is useful for sessions with large numbers of RTAS plug-ins.
- A lower number of processors leaves more CPU processing capacity for automation, screen redraws, and video playback in Pro Tools, or for other applications running at the same time as Pro Tools.

**To set the number of RTAS Processors:**

2. From the RTAS Processors pop-up menu, select the number of available processors you want to allocate for RTAS plug-in processing.
3. Click OK.
CPU Usage Limit

The CPU Usage Limit controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the RTAS Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.

- Lower CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.

- Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more real-time plug-ins.

The maximum available CPU Usage Limit depends on the number of processors in your computer and on the number of processors you specify for RTAS processing. This value can range from 85 percent for single-processor computers to 99 percent for multi-processor computers.

⚠️ Increasing the CPU Usage Limit may slow down screen response on slower computers.

To change the CPU Usage Limit:


2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.

3. Click OK.

RTAS Engine (RTAS Error Suppression)

The RTAS Engine options determine RTAS error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable RTAS error suppression if you are experiencing frequent RTAS errors that are interrupting your creative workflow. When RTAS error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable RTAS error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

There are two RTAS Engine options:

Ignore Errors During Playback/Record When enabled, Pro Tools continues to play and record even if the RTAS processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, as well as additional latency, but does not stop the transport. This will only suppress errors in the RTAS engine. Disk-based errors (if any) will continue to stop the transport.

Minimize Additional I/O Latency (Mac OS X Only) When enabled, any additional latency due to suppressing RTAS errors during playback and record is minimized to 128 samples. Suppressing RTAS errors requires at least 128 samples of additional buffering on some systems. If this option is disabled, the buffer is half the H/W Buffer Size, or at least 128 samples (which ever is greater). If you are on a slower computer, you may not want to enable this option since doing so can adversely affect performance.
The Minimize Additional I/O Latency option is only available if the Ignore Errors During Playback/Record option is enabled.

To enable RTAS error suppression:
2. Select Ignore Errors During Playback/Record.
3. On Mac OS X, you can also select Minimize Additional I/O Latency.
4. Click OK.

DAE Playback Buffer Size
The DAE Playback Buffer Size determines the amount of memory DAE allocates for disk buffers. The optimum DAE Playback Buffer Size for most disk operations is Level 2.

- DAE Playback Buffer Size settings lower than Level 2 may improve playback and recording initiation speed, but may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily fragmented hard drives.
- DAE Playback Buffer Size settings higher than Level 2 will allow for a higher density of edits in a session or a higher track count when using slower hard drives. However, a higher setting can also cause a time lag to occur when starting playback or recording, or longer audible time lag while editing during playback.

Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of Level 2 is recommended unless you are encountering -9073 (“Disk too slow or fragmented”) errors.

To change the DAE Playback Buffer Size:
2. From the DAE Playback Buffer pop-up menu, select a buffer size.
3. Click OK.

MIDI Studio Setup
(Windows Only)
If you plan to use any MIDI devices with Pro Tools, configure your MIDI setup with MIDI Studio Setup. See Appendix A, “Configuring MIDI Studio Setup (Windows Only)” for details.

Audio MIDI Setup (AMS)
(Mac Only)
If you plan to use any MIDI devices with Pro Tools, configure your MIDI setup with the Apple Audio MIDI Setup (AMS) utility. See Appendix B, “Configuring AMS (Mac OS X Only).”
**Pro Tools Hardware Settings**

Pro Tools lets you set the default sample rate and clock source for your system, and configure the digital inputs on the 003 or 003 Rack.

**Default Sample Rate**

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

- You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. See the Pro Tools Reference Guide for details.

**To change the default Sample Rate:**

1. Choose Setup > Hardware.

![Hardware Setup dialog](image)

2. Select the sample rate from the Sample Rate pop-up menu.

3. Click OK.

**Clock Source**

The Pro Tools Hardware Setup dialog lets you select the Clock Source for the system.

- **Internal** If you are recording an analog signal directly into Pro Tools (or using an external analog or digital device for effects), you will usually use the Internal setting.

- **External** If you are transferring material into Pro Tools from an external digital device, or if you utilize a common house clock signal, you will synchronize Pro Tools to the digital device or common signal. The external clock source corresponds to the connector on the back of the 003 or 003 Rack that is receiving your clock signal: S/PDIF (RCA), Optical, or Word Clock. If you are using an optical device, you also need to set the Optical Format (ADAT or S/PDIF).

- You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time. At 96 kHz, it is recommended that you use the S/PDIF (RCA) port.

- Note that S/PDIF (RCA) output is still available when S/PDIF Optical is selected.
To select the Clock Source:

1. Choose Setup > Hardware.
2. Choose the clock source from the Clock Source pop-up menu.
3. Click OK.

Optical Format

The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O. The Optical Format ADAT option is replaced by None for session rates 88.2 kHz and 96 kHz.

If you are using an optical device for recording, you need to set the Optical Format.

To select the digital format of the Optical I/O port:

1. Choose Setup > Hardware.
2. In the Optical Format section, do one of the following:
   - Select ADAT if your optical device is using the ADAT format.
   - or –
   - Select S/PDIF if your optical source device is using the S/PDIF format.
3. Click OK.

⚠️ Your digital input device must be connected and turned on for Pro Tools to synchronize to it. If your input device is not turned on, leave the Clock Source set to Internal.

⚠️ Only one S/PDIF input pair can be used at a time. When you select S/PDIF (RCA) as the Clock Source, the Optical Format setting will switch to ADAT (for sample rates 44.1 kHz and 48 kHz), or to None (for sample rates 88.2 kHz and 96 kHz).

Conversely, when you select S/PDIF as the Optical Format, the Clock Source setting will switch to Internal if it was previously set to S/PDIF (RCA).

3. Click OK.
Configuring I/O Setup

Using the I/O Setup dialog, you can label Pro Tools LE input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the 003 and 003 Rack.

Pro Tools LE has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename the default I/O paths.

To rename I/O paths in I/O Setup:
1. Choose Setup > I/O.

2. Click the Input, Output, Insert, or Bus tab to display the corresponding paths.

3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Enter (Windows) or Return (Mac).

4. Click OK.

See the Pro Tools Reference Guide (or choose Help > Pro Tools Reference Guide) for more information on renaming I/O paths.

Backing Up your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.
Chapter 6

003 Top Panel

003 Operating Modes

003 can be in any of five states when it is on:
- Standby mode
- Pro Tools mode
- MIDI mode
- Third Party Software mode
- Utility mode

Standby Mode

003 is in this mode when you first power on the unit, waiting for you to launch Pro Tools (or another supported application).

In Standby mode, the unit displays “003 Offline” in the top row of the 003 display and the Monitor Mute switch is enabled (lit).

In Standby mode, the Monitor section and MIDI I/O ports are available, without having to power on the computer.

Pro Tools Mode

003 is in this mode when the 003 unit is connected to a computer and Pro Tools LE software is running.

If Pro Tools is running and no Pro Tools session is open, the unit normally displays “Open or create a new session.” When a session is being launched, the display changes to “Loading a session.”

💡 If no session is open and a Workspace browser is open and being used for auditioning an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mirrors the on-screen controls. 003 faders, transport switches, rotary knobs, and switches control the corresponding elements in Pro Tools. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In Pro Tools mode, the Monitor section and MIDI I/O ports are available with a session open or closed.

To put 003 in Pro Tools mode:

1. Make sure the 003 unit is properly connected to the computer and powered on.
2. If Mute is disabled (unlit), enable Mute by pressing the Monitor Mute switch so that it is lit.
3. Launch Pro Tools LE and open or create a Pro Tools session.
**MIDI Mode**

003 is in this mode when either the MIDI Map A or B switch is enabled (lit). In this mode, 003 functions as a MIDI control surface for external devices and applications other than Pro Tools. For more information, see the **003 MIDI Mode Guide**.

**Third Party Software Mode**

003 is in this mode when the 003 unit is connected to a computer and you launch a third party audio application (such as iTunes or Ableton Live), and then use 003 as your playback or recording device. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In this mode, the unit displays “Working...” in the top row of the LCD.

On Windows, ASIO- and WaveDriver-compatible applications are supported. WaveDriver supports playback only. On Mac, CoreAudio Driver applications are supported.

For more information on third party audio drivers, see the Windows Audio Drivers Guide (for ASIO or WaveDriver on Windows) or the CoreAudio Drivers Guide (Mac).

**To use a third party software application with 003:**

1. Make sure 003 is properly connected to the computer and in Standby mode.
2. Configure your system and software for ASIO, WaveDriver, or CoreAudio Driver.

See the Windows Audio Drivers Guide (for ASIO and WaveDriver on Windows) or the CoreAudio Drivers Guide (Mac).

3. If Mute is disabled (unlit), press the Monitor Mute switch.
4. Launch your third party audio application.
5. Disable the Monitor Mute switch (unlit).
6. Use monitor section controls and switches to adjust audio input routing, monitor levels, and headphone levels.

**Playing Audio** Audio from your third party software application can be routed to 003’s outputs, via the FireWire connection.

**Recording Audio (ASIO Driver and CoreAudio Driver Only)** Audio from 003 inputs can be routed to software inputs in your third party software applications, via the FireWire connection.

Refer to the documentation for your third party software for information on configuring inputs and outputs.

**Utility Mode**

003 is in this mode when the Utility switch is enabled (flashing). In Utility mode, you can run pre-programmed diagnostic tests of the 003 unit (such as fader movement and LEDs). The Utility switch is unavailable in Pro Tools mode.

See Appendix C, “Utility Mode (003 Only)” for more information.
003 Top Panel Overview

Figure 1 identifies each of the main 003 control sections.

The 003 top panel is arranged in sections of controls with related functions. The Fader section includes standard channel strip controls, similar to any small-format mixer. The Console/Channel View section provides powerful multi-state controls for viewing and controlling inserts, plug-ins and sends in Pro Tools. The Transport and Navigation controls provide access to many of the on-screen navigation features of Pro Tools.
Display Section

The top portion of the 003 includes an LCD display, Display mode switch, and status indicators.

**LCD Display**

For all 003 operating modes, the LCD display provides status information.

For information on the status information displayed for each 003 operating mode, see “003 Operating Modes” on page 31.

In Pro Tools mode, when a session is open, 003’s LCD is a large, two-row display. The LCD display dedicates two rows, each with up to six characters, to each channel strip.

In most views, the top row of the LCD shows the the current view or mode status on the left side and the session’s Main Counter on the right side.

The bottom row of the LCD shows track, send, and insert names, and pan position, send levels, and plug-in control information, depending on the current view, as selected by the Channel/Console switches.

The default display is the name of the displayed element. Names of items with more than six characters are abbreviated to six characters. Full names of items with more than 6 characters can be temporarily displayed in the LCD. See “Displaying Full Names of Tracks, Insert Parameters, and Other Elements” on page 90.

When you move a fader or rotary encoder, the LCD will temporarily display the value for that control in the lower row of the LCD, then return to the default display. Values can also be temporarily displayed without moving a control or set to display always. See “Displaying Settings Instead of Track or Control Names” on page 90.

Additional LCD Naming Conventions in Pro Tools Mode

When a send or insert is muted, its names is capitalized in the LCD display.

When a track, send, or insert is inactive, “@” appears before its name in the LCD display.
Display Mode Switch

This switch is used to change default LCD displays:

• Full names of items with more than 6 characters can be temporarily displayed in the LCD. See “Displaying Full Names of Tracks, Insert Parameters, and Other Elements” on page 90.

• The lower row of the LCD shows track or control names by default. The display can be changed to temporarily show settings by pressing and holding the Display Mode switch, or be reset to always show settings. See “Displaying Settings Instead of Track or Control Names” on page 90.

The Display Mode switch flashes during a temporary display or when the LCD default has been reset to always show settings.

Host (“1394”) Status Indicator

The Host status LED, marked “1394” below its LED, indicates that communication has been established between the unit and Pro Tools LE software (or another software application) through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source. When the current clock source is not established, the respective LED flashes.

If none of the Sync LEDs are lit, 003’s clock source is set to internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of MIDI data on the MIDI In, MIDI Out 1, or MIDI Out 2 ports. Individual LEDs are provided for each port. Active sensing is not indicated.
The Fader section consists of eight channel strips, each with identical controls.

Each fader has a motorized touch-sensitive fader, solo and mute switches, a multi-state Channel Select switch, a rotary encoder and its LED ring, and meter LEDs. The LCD display dedicates two rows, each with up to six characters, to each channel strip.

Channel Strip Controls

Channel Faders

Each channel has its own 100 mm, servo-driven, touch-sensitive, motorized fader for controlling levels of audio, Auxiliary Input, Master Fader, MIDI, and Instrument tracks.

Flip Mode

In Flip mode (Flip switch lit), rotary encoder controls are taken over by the faders, which makes the rotary encoders available to control another parameter. For example, in normal Send View (Send switch lit), rotary encoders control send level, while faders control output gain. In Flip mode, faders (instead of rotary encoders) control the send level parameters and rotary encoders control pan.

For more information, see “Using Flip Mode” on page 98.

Muting Fader Movement

Because 003 faders are motorized, they move to follow automation when playing back and recording (when the track is set to an automation read or write mode, and not Off). During critical listening passes, the sound of the fader motors and their automated movements may be distracting. You can temporarily shut off (or mute) motorized fader movement using the Fader Mute switch.
When the Fader Mute switch is enabled (flashing), faders park and do not respond to touching or movement. Previously recorded automation continues to affect playback, while the faders are disengaged from reading.

For more information, see “Muting Fader Movement” on page 100.

Channel Solo/Mute Switches

Each channel has Solo and Mute switches, located above its fader. These switches let you solo or mute the channel. The switches also show the Pro Tools solo and mute status for each track. When a track is soloed (Solo switch lit), the Mute switches on other tracks in the session flash. When a track is muted, its Mute switch is lit continuously.

The Solo switch function follows the Pro Tools Operation preference for latched operation. (See the Pro Tools Reference Guide for details.)

Channel Select Switches

Each channel has a Channel Select switch that performs several functions, depending on the view or mode, as follows.

Console View Depending on the Console View (Pan, Send, or Insert), 003 can be used to do the following:

- Select tracks or inserts on a particular channel for editing.
- Assign inputs, outputs, sends, or inserts (plug-ins or hardware).
- Open track or send Output windows.
- Make track or send Outputs active or inactive.
- Select pre- or post-fader operation for sends.
- Bypass plug-ins.
- Reset faders and other parameters to their default settings.

For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”

Channel View Depending on the Channel View (EQ, Dynamics, Insert, or Pan/Send), 003 can be used to do the following:

- Display inserts or plug-ins on a channel.
- Select and edit individual send or insert settings as displayed across the LCD.
- Toggle switched plug-in controls (such as bypass and Phase Invert).
- Cycle through plug-in windows.

For information on using Channel View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”
**Record Arming Mode** When the Rec Arm switch is enabled (flashing), the Channel Select switch for a track enables or disables its Record Enable button, plus acts as a record-enabled indicator. When a track is record-enabled, its Channel Select switch flashes when the Transport is stopped. When Pro Tools is recording, the switch is lit continuously.

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.

See “Rec Arm (Record Arm) Switch” on page 39 for details on record-enabling tracks.

**Automation Mode** The Automation Mode switches (Write, Touch, Latch, Read, and Off) let you use the Channel Select switches to set the track’s Automation mode.

See “Automation Section” on page 48 for more information.

**Memory Location Mode** In this mode (Memory Location switch lit), Channel Select switches recall the Memory Location that corresponds to their channel number. Additionally, the Memory Location window can be opened.

See “Working With Memory Locations” on page 98 for more information.

**Rotary Encoders**

Each Channel has a rotary encoder. These knobs control a variety of parameters, depending on the view:

**Console View** The rotary encoders control pan, send level, or insert settings, depending on which Console View is enabled (Pan, Send, or Insert).

**Channel View** The rotary encoders control plug-in, pan/send, or insert settings, depending on which Channel View is enabled (EQ, Dynamics, Insert, or Pan/Send).

**Rotary Encoder LEDs**

Each rotary encoder has a ring of 11 LEDs for indicating data values controlled by the encoder. The style of display depends on the type of data. For example, discrete or stepped information such as pan position or frequency value is shown by a single LED, while an expanding series of LEDs shows values such as send levels, gain, or filter bandwidth. When you rotate the encoder, its LEDs update.

In Pan View, the Meter switch sets what the LEDs display (left pan, right pan, or no function in Automation mode).

**Channel Meter LEDs**

Each channel includes a five-segment LED meter, scaled at 0, –3, –6, –12, and –42 dBFS for track level. The meters are also labeled to indicate the track’s current Automation mode: Wrt (Write), Tch (Touch), Lch (Latch), or Rd (Read).

When the Meter switch is set to Left or Right, these meters display track level. When the Meter switch is set to Auto (Automation), the meter indicator corresponding to the track’s current Automation mode is lit.
**Meter Switch and LEDs**

The Meter switch (located to the right of the encoder row) configures the display mode for Channel Meter LEDs and the rotary encoder LEDs.

The Meter switch also sets whether Left or Right pan is controlled by a channel’s rotary encoder.

When you toggle through the three Meter switch modes, the corresponding Meter switch LED lights when its mode is enabled, as follows:

- **Left** When enabled (LED lit), the Channel Meter LEDs function as level meters, displaying mono signals or the left channel of a stereo signal. Rotary encoder LEDs indicate the left pan position (available on stereo channels or sends). Additionally, the rotary encoder can be used to adjust the left pan position on stereo channels or sends.

- **Right** When enabled (LED lit), the Channel Meter LEDs function as level meters, displaying the right channel of a stereo signal. Rotary encoder LEDs indicate the right pan position (available on stereo channels or sends). Additionally, the rotary encoder can be used to adjust the right pan position on stereo channels or sends.

- **Auto (Automation)** When enabled (LED lit), the Channel Meter LEDs display the Automation mode for their channel. When the Auto switch is enabled, the rotary encoders do not function.

**Global Fader Controls**

The following controls affect the assignment and operation of all the faders:

**Rec Arm (Record Arm) Switch**

When the Rec Arm switch is enabled (flashing), 003 is in Record Arming mode. In this mode, channels can be armed (record-enabled) or disarmed for recording by pressing their Channel Select switch.

For information on how to record arm tracks with 003, see “Recording” on page 96.

In this mode, the top row of the LCD shows “Record Arm” and the lower row of the LCD shows track names. Additionally, volume fader updates will not be reflected in the LCD, panning cannot be adjusted with rotary encoders, and the Display mode cannot be changed.

In Record Arming mode, the Channel Select switches act as record-enable switches and indicators. When a channel is record-enabled and the transport is stopped (or playing back without recording), its Channel Select switch flashes. When Pro Tools is recording, it is lit continuously.

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.
**Mstr Faders (Master Faders) Switch**

When enabled (flashing), the Master Faders switch arranges all Master Fader tracks in the current session on the right-hand side of the control surface. Pressing this switch a second time returns the control surface to the previous view.

In Pan View, the Master Fader levels are displayed in the LCD.

**Fader Flip Switch**

When enabled (flashing), the Flip switch invokes Flip mode. Flip mode transfers control assignments from the rotary encoders to the corresponding channel faders, allowing you to use the touch-sensitive faders to edit and automate send and plug-in values. Additionally, in certain views, the rotary encoders are available to control another parameter.

Flip mode is not available in Pan View.

See “Using Flip Mode” on page 98 for more information.

**Default Switch**

The Default switch is used in conjunction with a Channel Select switch to reset a fader (or fader-mapped plug-in parameter) to its default setting. For example, you can reset a channel volume fader to its default level of 0.0 dB.

See “Setting Track Controls to Defaults” on page 97 for more information.

**Input Switch**

The Input switch toggles Auto Input and Input Only Monitor mode for record-enabled tracks.

See the Pro Tools Reference Guide for more information about Pro Tools input monitoring modes.
**Console/Channel View Section**

The Console and Channel View sections give you control over many on-screen elements in Pro Tools.

---

**003 Console and Channel View switches**

Both Console and Channel Views let you view and access pan, sends, or plug-ins for editing, and automation.

**Console View Switches**

Console View switches let you toggle 003 to show pan position, send assignments, or insert assignments for all channels on the control surface.

003 is in Console View when any of the Console View switches (Pan, Send, or Insert) is lit in the Console View section.

*When you first open a Pro Tools session, the top row of the 003 is in Console View with the Pan switch enabled (lit). This default view is sometimes called the Home View.*

Think of Console View as a global view of a given control type across the entire mixer console (such as send A for Channels 1–8).

---

**Insert/Send Position Switches**

These switches determine which of the five available insert positions (marked A–E in Pro Tools) or ten available send positions (marked A–J in Pro Tools) are displayed in Console View.

For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”

There are three Console Views, based on their corresponding switch name:

**Pan Switch** When enabled (lit), 003 is in Pan View. This is the default View when you first open a Pro Tools session.

In this view, rotary encoders adjust channel pan positions, and faders adjust track volume. The bottom row of the LCD shows the track names, and temporarily shows the channel pan posi-
tions when the encoder is moved, or volume information when the fader is moved. The top row of the LCD shows the pan mode (left or right) and Main Counter.

**Send Switch** When enabled (lit), 003 is in Send View. In this view, rotary encoders adjust Send level and the faders adjust track volume. The bottom row of the LCD shows the names of currently assigned sends across all channel strips for a given send position (Sends A–J in Pro Tools). The top row of the LCD shows the send position and Main Counter.

**Insert Switch** When enabled (lit), 003 is in Insert View. In this view, the bottom row of the LCD shows the names of currently assigned inserts (hardware inserts or plug-ins) across all channel strips for a given insert position (Inserts A–E in Pro Tools). The top row of the LCD shows the insert position and Main Counter.

**Channel View Section Switches**

The first four Channel View switches determine the type of information displayed for a selected track. The first two switches focus on particular types of plug-ins (EQ and Dynamics), while the second two address all types of inserts and sends.

*For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”*

The Channel View section also includes Page Left, Page Right, Master Bypass, and ESC switches.

003 is in Channel View when any of the first four Channel View Select switches (EQ, Dynamics, Insert, or Pan/Send) is lit in the Channel View section.

Think of Channel View as a way to temporarily focus on all the plug-ins, inserts or sends on a single channel.

**EQ Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with equalizer plug-ins assigned to them by illuminating their Channel View switches. The top row of the LCD shows “Select EQ” and the Main Counter. The bottom row shows track names.

**Dynamics Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with dynamics plug-ins (such as compressors or limiters) assigned to them by illuminating their Channel Select switches. The top row of the LCD shows “Select Dynamics” and the Main Counter. The bottom row shows track names.
**Insert Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with any kind of insert assigned to them (including plug-ins or hardware I/O inserts) by illuminating their Channel Select switches. The top row of the LCD shows “Select Insert” and the Main Counter. The bottom row shows track names.

**Pan/Send Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with sends assigned to them by illuminating their Channel Select switches. The top row of the LCD shows “Select Pan Send A–E” and the Main Counter. The bottom row shows track names.

**Page Switches** These switches provide access to additional pages of sends, plug-in parameters or Memory Locations. The Page switches flash to indicate a next or previous page is available.

**Plug-in Master Bypass Switch** This switch lets you bypass either a single plug-in or all plug-ins on a channel, depending on the current view.

**ESC (Escape/Cancel) Switch** When flashing, this switch acts as a cancel button for certain operations on 003 (such as Channel View selections) and many on-screen dialogs in Pro Tools.
Transport and Navigation Controls

The 003 provides a standard set of Transport controls that mirror Pro Tools on-screen controls (when in Pro Tools mode) and conform to standard MMC commands for controlling other devices (in MIDI mode). Navigation keys and shortcut switches support Pro Tools zooming, banking, and navigation features.

Transport Controls

These controls correspond to transport functions in Pro Tools.

RTZ (Return to Zero) Sets the playback cursor to the beginning of the session.

REW (Rewind) Rewinds through the session from the current cursor position.

FFW (Fast Forward) Fast-forwards through the session from the current cursor position.

STOP Stops playback or recording.

Play Begins playback from the current cursor position.

Record Arms Pro Tools for recording. Clicking Play then initiates recording on record-enabled tracks only.
**Jog/Shuttle Wheel**

The dual-concentric Jog/Shuttle wheel provides additional navigation controls.

**Shuttle Mode**

The outer ring of the Jog/Shuttle wheel is a Shuttle control. When you move the Shuttle ring, 003 enters Shuttle mode. In this mode, you can play forwards or backwards at a variable rate, depending on the Shuttle position. Full clockwise and counter-clockwise positions provide the fastest shuttle rates. The Shuttle ring returns to the center position (no shuttling) when you release the wheel.

*For more information, see “Navigating with the Shuttle/Jog Wheel” on page 96.*

**Jog Mode**

The inner part of the Jog/Shuttle wheel is a Jog control. When you move the Jog wheel, 003 enters Jog mode. In this mode, you can move the session transport (and cursor) forwards or backwards.

*For more information, see “Navigating with the Shuttle/Jog Wheel” on page 96.*

The Jog control can be used to bank tracks to different faders.

*For more information, see “Banking Channels on 003” on page 99.*

The Jog control can also be used to continuously zoom in or out horizontally or vertically on all tracks.

*For more information, see “Working With Memory Locations” on page 98.*

**Jog/Shuttle Wheel Takeover**

When using the Jog/Shuttle wheel, keyboard and mouse commands are not supported, and most 003 controls are unavailable. 003 faders can be used at the same time as the Jog/Shuttle wheel. However, 003 transport controls disable the Jog/Shuttle wheel.

Normal operating mode is returned a few seconds after last touching the Jog/Shuttle wheel.

**Navigation and Display Keys and Switches**

These multi-purpose keys and switches control the display of Pro Tools tracks on the 003 control surface, on-screen zoom functions, and other Pro Tools navigation functions.

**Arrow Keys**

The Arrow keys are used to navigate tracks, zoom in and out, navigate in text entry fields, and drop Selection In and Out markers on-the-fly.

For more information, see “Navigating with the Shuttle/Jog Wheel” on page 96.

For more information, see “Banking Channels on 003” on page 99.

For more information, see “Working With Memory Locations” on page 98.

For more information, see “Navigating with the Shuttle/Jog Wheel” on page 96.

Bank, Nudge, and Zoom switches

Navigation and Display keys and switches

Basic Arrow key functionality is defined by the Display switches.
Fader Bank, Nudge, and Zoom Display Switches

The Display switches define basic Arrow key functionality, as follows:

Bank Switch When enabled (lit), the Arrow keys let you bank 003 fader strips to the previous or next eight tracks. You can also control and adjust selections and scroll in the Pro Tools Edit window.

Nudge Switch When enabled (lit), the Arrow keys let you nudge the display of tracks on 003 one track at a time. You can also control and adjust selections and scroll in the Pro Tools Edit window.

Zoom Switch When enabled (lit), the Arrow keys zoom the Pro Tools Edit window display.

Additional Arrow Key Functionality

You can use the Arrow keys to perform additional functions in Pro Tools, regardless of the active Display switch.

For more information, see “Navigating in the Edit Window” on page 96.

Windows Show/Hide Switches

Plug-in Switch Opens or closes the window for the currently selected plug-in

Mix Switch Opens, brings forward, or closes the Pro Tools Mix window

Edit Switch Opens, brings forward, or closes the Pro Tools Edit window

Record/Playback Transport Mode Switches

Loop Play Switch Toggles Loop Playback on and off

Loop Rec Switch Toggles Loop Record mode on and off

QuickPunch Switch Toggles QuickPunch Record mode on and off

Mem Loc (Memory Location) Switch

The Mem Loc (Memory Location) switch provides access to all Memory Locations in a Pro Tools session and can be used to set Memory Locations.

For more information, see “Working With Memory Locations” on page 98.
**Miscellaneous Switches**

**Save Switch** Pressing the Save switch twice is equivalent to choosing File > Save in Pro Tools.

**Undo Switch** Pressing the Undo switch is equivalent to choosing Edit > Undo in Pro Tools. (See the Pro Tools Reference Guide for details on multiple undo capabilities.)

**Enter (OK) Switch** Pressing the Enter switch is equivalent to pressing Return or Enter on the computer keyboard. This lets you OK on-screen dialogs or create new Memory Locations in Pro Tools directly from the control surface.

**Utility Switch** When enabled (lit), 003 enters Utility mode. In this mode, you can run pre-programmed diagnostic tests of the 003 unit (such as fader movement and LEDs) and reset MIDI mappings to their factory presets. The Utility switch is unavailable in Pro Tools mode.

For more information, see Appendix C, “Utility Mode (003 Only)” for more information.

**Fader Mute** In Pro Tools mode, this switch temporarily suspends 003 fader movement. When enabled (flashing), this lets you work with Pro Tools and monitor audio playback without fader noise.

The Fader Mute feature has no effect on fader automation or audio levels during playback.

To toggle fader movement on and off:

- While in Pro Tools mode, press the Fader Mute switch.

**Focus** In Pro Tools mode, this switch toggles the LCD display between the current plug-in view and the previous 003 view (such as Console or Channel View).

To toggle between a plug-in view and the original view:

- Press the Focus switch.

**MIDI Map Switches**

003 provides switches for using the control surface as a MIDI controller.

For more information, see the 003 MIDI Mode Guide.

**MIDI Map A and B Switches** When one of these switches is enabled (lit), 003 is in MIDI mode. In this mode, 003 functions as a MIDI control surface for external devices and applications other than Pro Tools. 003 supports two different banks of MIDI Map presets, corresponding to MIDI Map switch A and B.

**MIDI Edit** In MIDI mode, this switch lets you edit and name custom MIDI maps.

**MIDI Recall** In MIDI mode, this switch lets you recall and select MIDI map presets.
**Automation Section**

This section provides switches for controlling how automation data is written and played back.

**Automation Mode Switches**

The Write, Touch, Latch, Read, and Off switches are used to set the Pro Tools Automation mode for any track.

When the Meter switch is set to Auto, the Meter LEDs for each channel display its Automation status.

*For more information, see “Working with Automation” on page 100.*

**Automation Switch LEDs**

The Write, Touch, Latch, and Read switch LEDs individually light when at least one channel has the corresponding Automation mode. The Off switch LED flashes when no channels are set to Write, Touch, or Latch, and at least one channel’s Automation mode is set to Off.

Multiple LEDs light when there are channels with different Automation modes.

**Suspend Switch**

When enabled (flashing), automation is suspended for all channels.

*For more information, see “Working with Automation” on page 100.*

**Modifiers Section**

The Modifiers section includes four switches for modifying commands in combination with 003 switches, keyboard shortcuts, and Right-click commands in Pro Tools:

**Shift (Add) Switch** This switch lets you extend a track selection or add to a group of selected items.

**Option/Alt (All) Switch** This switch lets you apply an action or command to all tracks in a Pro Tools session.

**Ctrl/Win Switch** This switch lets you temporarily disengage a control from grouped behavior.

**Command/Ctrl Switch** This switch lets you fine-adjust controls and automation breakpoints.

*003 keyboard modifier keys*
**003 Shortcuts**

Modifier switches provide shortcuts for 003 functions that can be accomplished without using your computer’s keyboard or mouse.

*For a list of 003 shortcuts, see “003 Top Panel Shortcuts” on page 101.*

**Pro Tools Shortcuts**

For increased operational speed, there are many Pro Tools keyboard and Right-click shortcuts to give you fast access to a wide variety of tasks. These shortcuts in Pro Tools use *modifier keys*, (such as the Shift key) which are pressed in combination with other keys or with a mouse action.

003 Modifier switches mirror the functions of modifier keys on the computer keyboard. For example, 003’s Shift (Add) switch is equivalent to your keyboard’s Shift key.

You can use the Modifier switches in any combination with keys on your computer or a mouse action while working with Pro Tools.

*For a complete list of Pro Tools keyboard and Right-click shortcuts, refer to the Shortcuts Guide for your computer platform.*

---

**Mic/DI Input Controls**

There are four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel.

Inputs 1–4 show up as “Analog 1–4” in the default Pro Tools I/O Setup.

**Mic/DI Input Controls for Inputs 1–4**

Inputs 1–4 have the following controls:

- **Input 1–4 Gain Controls** Each knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.

- **Mic/DI Switches (Inputs 1–4)** Each switch toggles the corresponding input between microphone (unlit) or DI input (lit).

The Di and Mic switch LEDs indicate the current source input. The LEDs blink rapidly when the input is clipping.

⚠️ *Engage the Mic switch only if you have an XLR cable plugged into the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.*

- **HPF (High Pass Filter) Switches (Input 1–4)** These switches enable a high pass filter (75 Hz, 12 dB/octave rolloff) on the corresponding input, for filtering out rumble or AC hum. The HPF LEDs are lit when the switch is enabled.

---

<table>
<thead>
<tr>
<th>003 Switch</th>
<th>003-to-QWERTY (Mac)</th>
<th>003-to-QWERTY (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift (Add)</td>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>Option/Alt (Alt)</td>
<td>Option</td>
<td>Alt</td>
</tr>
<tr>
<td>Ctrl/Win</td>
<td>Control</td>
<td>Win</td>
</tr>
<tr>
<td>Command/ Ctrl</td>
<td>Command</td>
<td>Control</td>
</tr>
</tbody>
</table>
Monitor Section

The Monitor section provides the following control room monitoring features:

### Alternate Input Routing Controls

**Aux In to 7/8 Switch** This switch routes the Aux In input pair directly to Inputs 7 and 8 of Pro Tools, and does not send it to the Main Monitor Outputs. This lets you route an alternate input signal (such as a CD player) directly into Pro Tools without the need to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog Inputs 7–8 are disabled.

**3/4-HP2 Switch** This switch sets the Headphone 2 Output to mirror Output pair 3–4.

**Aux In (to Monitor) Switch** This switch routes the Aux In input pair directly to the Main Monitor and Headphone Outputs.

**Alt CR (Control Room) Switch** This switch mutes the Main Monitor output and routes the signal to the Alt Monitor output.

**Mono Switch** This switch temporarily combines Output 1–2 in the Main and Alt Monitor Outputs and the Headphone Outputs. This is helpful for checking the phase relationships of stereo material.

Monitor and Headphone Level Controls

**Monitor Level Control** These knobs control the volume of the Main and Alt Monitor Outputs. These outputs mirror Analog Outputs 1–2, which correspond to outputs 1–2 in Pro Tools.

**Headphone 1 and 2 Level Controls** These knobs control the volume of the independent Headphone Outputs. The Headphone Outputs normally mirror outputs 1–2 in Pro Tools, and are independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3–4 when the 3/4-HP2 switch is enabled (lit). Both headphones include Aux In signal when Aux In (to monitor) is enabled.

Headphone output is not affected by the status of the Monitor Mute switch, but does follow status of the Mono switch.

**Monitor Mute Switch** This switch mutes the Main and Alt Monitor Outputs only, and has no effect on the Headphone Outputs. Monitor Mute is automatically engaged when you power up the unit.

**Headphone Jacks**

Headphone Output 1 and 2 jacks accept standard 1/4-inch stereo headphone connectors. The jacks are located on the front of the 003.
The 003 Rack front panel includes controls for Inputs 1–4, options for routing outputs and monitoring alternate input sources, and indicators for connections status, sync source, and MIDI data.

**Power Switch**

The Power switch is located on the front panel.

**Headphone Jacks**

Headphone Output 1 and 2 jacks accept standard 1/4-inch stereo headphone connectors.
Mic/DI Input Controls

There are four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel.

Inputs 1–4 show up as “Analog 1–4” in the default Pro Tools I/O Setup.

Inputs 1–4 have the following controls:

Input 1–4 Gain Controls Each knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.

Mic/DI Switches (Inputs 1–4) Each switch toggles the corresponding input between microphone (unlit) or DI input (lit).

The DI/Mic switch LEDs indicate the current source input. The LEDs blink rapidly when the input is clipping.

⚠️ Engage the Mic switch only if you have an XLR cable plugged into the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.

HPF (High Pass Filter) Switches (Input 1–4)

These switches enable a high pass filter (75 Hz, 12 dB/octave rolloff) on the corresponding input, for filtering out rumble or AC hum. The HPF LEDs are lit when the HPF switch is enabled (lit).

Monitor Section

The Monitor section provides the following control room monitoring features:

Monitor and Headphone Level Controls

Headphone 1 and 2 Level Controls These knobs control the volume of the independent Headphone Outputs. The Headphone Outputs normally mirror outputs 1–2 in Pro Tools, and are independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3–4 when the 3/4-HP2 switch is enabled (lit). Both headphones include Aux In signal when Aux In (to monitor) is enabled.

Headphone output is not affected by the status of the Monitor Mute switch, but does follow status of the Mono switch.

Monitor Level Control These knobs control the volume of the Main and Alt Monitor Outputs. These outputs mirror Analog Outputs 1–2, which correspond to outputs 1–2 in Pro Tools.

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux In input pair directly to Inputs 7–8 of Pro Tools, and does not send it to the Main and Alt Monitor Outputs. This lets you route an alternate input signal (such as a CD player) directly into Pro Tools without the need to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog Inputs 7–8 are disabled.

3/4-HP2 Switch This switch sets Headphone 2 Output to mirror Output pair 3–4.
Aux In (to Monitor) Switch This switch routes the Aux In input pair directly to the Main Monitor and Headphone Outputs.

Alt CR (Control Room) Switch This switch mutes the Main Monitor output and routes the signal to the Alt CR output.

Mono Switch This switch temporarily combines Output 1–2 in the Main and Alt Monitor Outputs and the Headphone Outputs. This is helpful for checking the phase relationships of stereo material.

Monitor Mute Switch This switch mutes the Main and Alt Monitor Outputs only, and has no effect on the Headphone Outputs. Monitor Mute is automatically engaged when you power up the unit.

Status Indicators

Host ("1394") Status Indicator

The Host status LED, marked “1394” below its LED, indicates that communication has been established between the unit and Pro Tools LE software (or another software application) through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source. When the current clock source is not established, the respective LED flashes.

If none of the Sync LEDs are lit, 003 Rack’s clock source is set to Internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of MIDI data on the MIDI In, MIDI Out 1, or MIDI Out 2 ports. Individual LEDs are provided for each port. Active sensing is not indicated.
003 and 003 Rack Back Panels

The 003 and 003 Rack back panels include audio, MIDI and computer connectors for the unit (see Figure 3 on page 56). The functions of each connector and their associated switches are explained in this section.

The 003 and 003 Rack have identical connectors. The 003’s Power switch is on its back panel, whereas the 003 Rack’s Power switch is on its front panel.

⚠️ Digidesign does not recommend the use of unbalanced cables. Unbalanced connections may introduce noise into your audio system. Whenever possible, use balanced cables to make connections to 003 and 003 Rack.

Operating Levels and Headroom

All 003 and 003 Rack audio inputs and outputs are set for 14 dB of headroom below 0 dB, or full code. This means at the nominal reference input level (+4 dBu or –10 dBV) you can have up to 14 dB of headroom before input or output clipping occurs.

The maximum input and output of 003 or 003 Rack using balanced TRS cables on any of the +4 dBu, 1/4-inch connectors is +18 dBu (6.15 Vrms).

Sample Rate and Resolution Support

The Analog-to-Digital and Digital-to-Analog converters on all 003 and 003 Rack analog inputs and outputs, as well as the S/PDIF Digital I/O ports, support sample rates of 44.1, 48, 88.2, and 96 kHz. The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

All the analog and digital inputs and outputs on 003 and 003 Rack support up to 24-bit resolution audio.
Analog Inputs

Mic Inputs 1–4

These are balanced, three-conductor XLR connectors for microphone-level analog inputs. Gain is controlled by the corresponding Input Gain control (located on the top panel of 003, and on the front panel of 003 Rack). The source (Mic, Line, or DI) is chosen using the Mic/DI switch.

⚠️ The XLR connectors on Inputs 1–4 are wired specifically to match the impedance of microphones. Do not use these XLR connectors for line inputs; use the 1/4-inch connectors instead.

DI Inputs 1–4

The DI (“Direct Inject” or “Direct Interface”) Inputs are balanced connectors for guitars and other instrument level sources that support 1/4-inch TS connections. Operating levels for these inputs are fixed at +4 dBu.

Gain is controlled by the corresponding Input Gain knob (located on the top panel of 003, and on the front panel of 003 Rack). The source (Mic, Line, or DI) is chosen using the Mic/DI switch.

Phantom Power Switches

These switches apply 48V phantom power to Mic Inputs 1–2 and Mic Inputs 3–4 channel pairs, respectively. Enable these switches for microphones that require phantom power to operate.

🛡️ For more information, see “Phantom Power” on page 64.
Analog Inputs 5–8 and Operating Level Switches

Analog Inputs 5–8 are balanced, 1/4-inch TRS jacks for line-level analog audio input connections.

Operating levels for each of these line-level inputs is switchable between +4 dBu and –10 dBV, using the Operating Level switches immediately to the right of the input jacks.

While Inputs 5–8 do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection.

⚠️ Analog Inputs 7–8 are disabled when the Aux In to 7/8 switch is enabled (lit).

Analog Outputs

Main Analog Outputs 1–8

These are impedance balanced, 1/4-inch TRS jacks for line-level analog audio output connections. Operating levels for these outputs are fixed at +4 dBu.

While the Main Analog Outputs do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection.

⚠️ If you plan on connecting Analog Outputs 1–8 to –10 dBV gear, you may want to place a transformer-based line level attenuator between the 003 or 003 Rack output and the input of the destination device to compensate for level differences.

Monitor Section

Main Monitor Outputs

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. To monitor your mix, these outputs can be connected to a mixing board, directly to a monitoring system (such as a stereo power amp, powered speakers, or another stereo destination).

The Main Monitor Outputs play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the top panel of 003, and on the front panel of 003 Rack).

Monitor output can be muted and the signal routed to the Alt CR Output with the Alt CR switch.

Alt Monitor Outputs

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. These outputs can be used to monitor your mix through an alternate, or secondary studio monitoring system, instead of the system connected to the Main Monitor Outputs.

The Alt Monitor Out Left and Right play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the top panel of 003, and on the front panel of 003 Rack).
These outputs are enabled when the Alt CR switch is enabled (lit).

**Aux In**

These are balanced, 1/4-inch TRS connectors for connecting alternate audio sources such as CD players or tape decks. The signal from these inputs can be routed directly to the Main Monitor Outputs (for monitoring) or to Inputs 7–8 (for direct input into Pro Tools) from the top panel of 003, or the front panel of 003 Rack.

Operating levels for these inputs are fixed at +4 dBu.

When the Aux In switch is enabled (lit), Aux In signal is routed to the Main Monitor Outputs. Audio in Pro Tools that is routed to Analog 1–2 will not be mirrored at the Monitor Outputs.

When the Aux In to 7/8 switch is enabled (lit), Aux In signal is routed to Inputs 7–8 and does not pass directly to the Monitor Outputs.

When the Alt CR switch is enabled (lit), audio routed to Aux In will pass out the Alt Monitor Outputs.

**Digital I/O**

**S/PDIF Digital I/O**

The S/PDIF in and out ports are unbalanced two-conductor phono (RCA) connectors that utilize a full 24-bit, two-channel digital data stream.

The Sony/Philips Digital Interface Format (S/PDIF) is used in many professional and consumer CD recorders and DAT recorders. For highest digital signal integrity, and lower jitter, use 75 Ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

The S/PDIF output channels always mirror the main outs 1–2.

003 and 003 Rack support **consumer mode** S/PDIF output format (IEC60958-3) at sample rates of 44.1 kHz and 48 kHz, and **professional mode** S/PDIF output format (IEC60958-4) at sample rates of 88.2 kHz and 96 kHz. For information on which S/PDIF formats are supported by your S/PDIF-compatible gear, see the manufacturer’s documentation.

**Optical I/O**

These are a pair of TOSLINK-style connectors for ADAT Optical (8 channels of I/O) or S/PDIF Optical (2 channels of I/O) devices. You can choose between these Optical I/O formats in the Pro Tools Hardware Setup dialog.

The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

The Optical I/O ports support 24-bit, 20-bit and 16-bit resolutions in both modes.

⚠️ **Only one S/PDIF input pair can be used at a time. For example, if you use the Optical In for S/PDIF data, you cannot use the RCA inputs.**

At 96 kHz, it is recommended that you use the S/PDIF (RCA) port

The Optical I/O ports use a standard optical “lightpipe” cable.

⚠️ **Digidesign recommends high-quality audio grade optical cable for all optical connections.**

When the 003 or 003 Rack is on, its Optical Out port emits a red light.
About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel optical digital audio connection developed by Alesis. Lightpipe is found on many devices, including ADAT decks, modular digital multitracks (MDMs), sound cards, standalone A/D or D/A converters, and digital consoles.

Word Clock

The Word Clock In and Out ports let you connect BNC cables to synchronize 003 and 003 Rack to incoming 1x Word clock, and synchronize other devices to Pro Tools-generated Word clock.

MIDI Connectors

The MIDI In and MIDI Out 1 and Out 2 ports are standard 5-pin MIDI ports. The MIDI In port supports 16 channels of MIDI input. Each MIDI Out port supports 16 channels of MIDI output, for a system total of 32 channels of MIDI output.

A MIDI driver for these MIDI ports is installed when you install Pro Tools LE, and is recognized automatically by MIDI Studio Setup (Windows) and Audio MIDI Setup (Mac). These connectors accept standard 5-pin MIDI cables.

Kensington Lock Port

Use the Kensington Lock port to secure your interface with a Kensington Lock (not supplied).

For more information, visit the Kensington website (www.kensington.com).

Footswitch Jack

This connector allows footswitch control of QuickPunch audio punch-in and punch-out, and MIDI punch-in and punch-out recording features. The footswitch connector is designed specifically for instantaneous (momentary) on/off pedals with a 1/4-inch TRS connector. Continuous on/continuous off pedals can also be used, but may result in unexpected behavior.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their IEEE specification, are commonly known as FireWire ports. These provide connections to the computer and other FireWire devices.

FireWire offers a high rate of data transfer and reliability that makes it ideal for audio applications (such as Pro Tools with 003 or 003 Rack). FireWire devices can be daisy-chained together without the need for terminators.

If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “4-Pin FireWire Cable” on page 13 for FireWire cable information.
Connecting 003 or 003 Rack and FireWire Hard Drives

The FireWire ports on 003 and 003 Rack do not pass audio data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to 003 or 003 Rack. This will prevent hard drive errors and data loss in case the 003 or 003 Rack unit is powered off.

⚠ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCM-CLA/ExpressCard FireWire options, visit the Digidesign website (www.digidesign.com).

Connecting Other FireWire Devices to 003 or 003 Rack

The second FireWire port on 003 or 003 Rack is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 and 003 Rack supply power from the computer through their FireWire ports, letting you recharge batteries in other FireWire devices.

Link Indicator

The Link indicator lights when a valid FireWire connection is established (between the 003 or 003 Rack and a computer).

Power Switch
(003 Back Panel Only)

The Power switch for 003 is located on its back panel.

The Power switch for the 003 Rack is located on its front panel

AC Power Connector

The AC power connectors on 003 and 003 Rack accept a standard modular AC power cable.

003 and 003 Rack are auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

⚠ 003 and 003 require AC power and cannot be powered by the FireWire bus.
chapter 9

Making Studio Connections

Getting Sound In and Out of Your 003 or 003 Rack

To hear audio recorded into a Pro Tools session, you will need to connect headphones or an external sound system (such as powered monitors or a home stereo) to 003 or 003 Rack. Sound from 003 and 003 Rack cannot be played through your computer’s speakers or your computer’s sound output.

Connecting Headphones

There are two stereo 1/4-inch headphone jacks on 003 and 003 Rack.

To connect headphones:
- Connect headphones with a 1/4-inch stereo connector (or adapter) to the Headphone 1 or 2 jack.

To adjust headphone levels:
- Adjust the Headphone 1 or 2 Level knobs.

To set Headphone 2 Output to mirror Output pair 3–4:
- Press the 3/4-HP2 switch.

Connecting a Sound System

The Main Monitor Outputs on the back of the 003 and 003 Rack support 1/4-inch plugs. These connections can be balanced, TRS (Tip, Ring, Sleeve) style connectors, or unbalanced connectors. To listen to your Pro Tools session, these outputs can be connected to any amplification system: powered speakers, a home stereo system, or an audio mixer.

An alternate monitoring system can be connected to the Alt Monitor Outputs.
When connecting to a stereo system, connect the left channel to Main Monitor Output L, and right channel to Main Monitor Output R.

**Main Monitor Outputs**

Main Monitor Outputs L and R play the audio that is routed to analog outputs 1 and 2 within Pro Tools.

The Monitor Level knob (located on the top panel of 003, and on the front panel of 003 Rack) adjusts the volume level of the Monitor Outputs.

You can also connect a sound system to any of the Analog Outputs 1–8, although you will not have Monitor section controls available.

If you plan on connecting Analog Outputs 1–8 to −10 dBV gear, you may want to place a transformer-based line level attenuator between the 003 or 003 Rack output and the input of the destination device to compensate for level differences.

---

**Mirroring the Outputs on S/PDIF Out**

When using 003 or 003 Rack with Pro Tools, you can send any pair of outputs (such as outputs 1–2) to the S/PDIF digital outputs at the same time by assigning the stereo mix to multiple output destinations. This is commonly known as mirroring the outputs.

Output mirroring is useful for recording to multiple media, creating separate monitoring mixes, or for output to digital effects processors.

For information on S/PDIF connections, see “Connecting Equipment with Digital Ins and Outs” on page 67

**To mirror 003 or 003 Rack Outputs 1–2 on the S/PDIF outputs:**

1. Open the Pro Tools session whose channel outputs you want to mirror.

2. In the Mix window, click the Output selector of any audio or Auxiliary Input track to select the main output destination, for example, Analog 1–2.

3. Start-click (Windows) or Control-click (Mac) the same Output selector and select an additional output pair from the same pop-up menu.
The newly selected destination is indicated by an additional check mark in the output pop-up menu, and a plus sign in the Output selector.

003 and 003 Rack have eight analog inputs. One set of inputs is labeled Mic Inputs 1–4 and DI Inputs 1–4, and the other four are labeled Analog 5–8. For stereo inputs, use an odd/even pair of inputs (for example, Input 5 for the left input, and Input 6 for the right input.

You cannot use both a Mic Input and DI Input with the same input number at the same time.

For information about connecting specific audio sources, see “Connecting a Microphone” on page 63, and “Connecting Instruments to 003 or 003 Rack” on page 65.

**Connecting Audio Inputs**

003 and 003 Rack inputs support microphones, guitars, keyboards, and other types of instruments.

**Mic Cables and Connectors**

Some microphone cables use an XLR connector to attach a microphone to an input (such as those on 003 and 003 Rack); other microphones use a 1/4-inch connector. If you have a choice, use an XLR connector to connect the microphone to the 003 or 003 Rack to yield better results.


Phantom Power

Some microphones require power to operate. This power, called *phantom power*, is supplied either by a battery in the microphone, or through an audio interface (such as 003 and 003 Rack) that can supply power through the microphone cable.

Most *condenser* microphones (such as an AKG C3000) require phantom power to operate. *Dynamic* microphones (such as a Shure SM57) do not require phantom power to operate, but are not harmed by it.

Although phantom power can be used safely with most microphones, ribbon microphones can be damaged by it. Always turn off phantom power and wait at least 30 seconds before connecting a ribbon microphone.

003 and 003 Rack can only supply power through a microphone cable with XLR connectors.

If you are not sure about the phantom power requirements for your microphone, see your microphone’s documentation or contact the manufacturer.

Using a Mic that Has an XLR Connector

**To use a microphone that has an XLR connector:**

1. On the back of the 003 or 003 Rack, plug your microphone cable into one of the Mic inputs. The inputs are numbered left to right, so Mic Input 1 is the leftmost input.

   ![XLR cable plugged into Mic Input 1](image)

2. Press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the Mic (unlit) position.

3. If your microphone requires phantom power, make sure the microphone is connected, then press the Phantom Power switch (labeled 48V) on the back of the 003 or 003 Rack for the corresponding input pair.
Each Phantom Power switch sends 48V to its corresponding input pair.

4 When Pro Tools is launched and the input is routed to a Pro Tools track (see “Recording a Pro Tools Session” on page 75), you can adjust the input level with the Input Gain knob (located on the top panel of the 003, and the front panel of the 003 Rack).

Using a Mic that Has a 1/4-Inch Connector

To use a microphone that has a 1/4-inch connector:

1. On the back of the 003 or 003 Rack, plug the 1/4-inch connector from your microphone into one of the DI inputs. From the back, the inputs are numbered left to right, so DI Input 1 is the leftmost input.

2. Press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the DI (lit) position.

3. When Pro Tools is launched and the input is routed to a Pro Tools track (see “Recording a Pro Tools Session” on page 75), you can adjust the input level with the Input Gain knob.

Connecting Instruments to 003 or 003 Rack

003 and 003 Rack support two types of inputs, which correspond to the signal strengths of different types of instruments. Instruments such as electric guitar or electric bass usually have a lower level of output than instruments and electronic audio sources such as mixers, samplers, keyboards, turntables, and synthesizers.

The higher level of output is commonly called “line-level” and the instruments that produce these higher levels are called line-level devices.
On 003 and 003 Rack, DI Inputs 1–4 support low-level instruments and line-level instruments. Analog Inputs 5–8 support line-level instruments only.

**To use a guitar with 003 or 003 Rack:**

1. On the back of the 003 or 003 Rack, plug your guitar cable into one of the DI inputs. From the back, the inputs are numbered left to right, so DI Input 1 is the leftmost input.

2. Press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the DI (lit) position.

3. When Pro Tools is launched and the input is routed to a Pro Tools track (see “Recording a Pro Tools Session” on page 75), you can adjust the input level with the Input Gain knob (located on the top panel of the 003, and the front panel of the 003 Rack).

**To use a keyboard or mixer with 003 or 003 Rack:**

1. On the back of the 003 or 003 Rack, plug your keyboard, mixer, or other audio source into any of the DI inputs or Analog Inputs by doing one of the following:
   - Use Analog Inputs 5–8 if you need to select –10 dBV or +4 dBu operating level for your keyboard.
   - Use DI Inputs 1–4 if Analog Inputs 5–8 are unavailable, or if you do not need to set the operating level. DI Inputs 1–4 are available even if a mic is connected to Mic Inputs 1–4 (although both cannot be active at the same time).

   For stereo inputs, such as a stereo keyboard or the stereo output from a mixer, use an odd/even pair of inputs. For example, connect the left channel to DI Input 1, and right channel to DI Input 2.

   From the back, the inputs are numbered left to right, so DI Input 1 is the leftmost input.
If you are using any DI inputs, press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the DI (lit) position.

If you are using any of the Inputs 5–8, set either a –10 dBV or +4 dBu operating level for the corresponding input using the Operating Level switch (located on the back panel). For information on the appropriate operating level for your input device, see the manufacturer’s specifications.

Set your instrument’s volume to its optimal level. For example, the optimal level for most keyboards is between 80% and 100% of maximum volume.

Adjust the Input Gain knob.

Connecting Equipment with Digital Ins and Outs

003 and 003 Rack each provide up to ten digital inputs and outputs, including:

- Eight channels of ADAT Optical input and output, or two channels of Optical S/PDIF input. Digidesign recommends high-quality audio grade optical cable for all optical connections.
- Two channels of S/PDIF digital input and output (RCA connectors)

Up to 18 channels of I/O can be achieved by using the S/PDIF RCA I/O, Optical (ADAT) I/O, and analog I/O at the same time.

Only one S/PDIF input pair can be used at a time. For example, if you use the optical input for S/PDIF data, you cannot use the RCA inputs. For more information on configuring Digital I/O, see “Configuring Pro Tools LE” on page 24.

For more information on each I/O type, see “Digital I/O” on page 58

For information on connecting digital effects devices, see “Using External Effects Devices” on page 69.

For information on recording from a Digital I/O, see “Recording from a Digital Device” on page 71.
To connect 003 or 003 Rack to a S/PDIF digital device using RCA cables:

1. Using RCA (coaxial) cables, connect the 003 or 003 Rack S/PDIF In to the S/PDIF output of the external device.

2. Connect the 003 or 003 Rack S/PDIF Out to the S/PDIF input of the external device.

To connect 003 or 003 Rack to a S/PDIF device using Optical (ADAT) cables:

1. Using an optical cable, connect the Optical output on the Optical device to the Optical In port on the 003 or 003 Rack.

2. Connect the Optical input on the Optical device to the Optical Out port on the 003 or 003 Rack. (When 003 or 003 Rack is on, its Optical Out port emits a red light.)

To connect 003 or 003 Rack to an ADAT device using Optical (ADAT) cables:

1. Using an optical cable, connect the Optical output on the ADAT device to the Optical In port on the 003 or 003 Rack.

2. Connect the Optical input on the ADAT device to the Optical Out port on the 003 or 003 Rack. (When 003 or 003 Rack is on, its Optical Out port emits a red light.)

Word Clock

003 and 003 Rack provide Word Clock In and Out connectors on the back panel that let you synchronize, or “clock” Pro Tools LE and the 003 or 003 Rack to industry standard Word clock. Word clock is used to synchronize a wide range of devices such as non-linear video systems and other types of equipment typically found in professional audio facilities.

With both Word clock input and output, your Pro Tools LE system can act as Word clock “slave” or “master.”

Do not confuse Word clock and other forms of “clock reference” with time code and other forms of “positional reference.” For an overview of synchronization terminology and concepts, see the Sync & Surround Concepts Guide.

To connect 003 or 003 Rack to Word clock:

- Using high-quality, 75 Ohm BNC cables (not included), connect the 003 or 003 Rack Word Clock In and Out connectors to the appropriate ports on the other Word clock-capable devices in your studio.

Using Word Clock with Pro Tools LE

Pro Tools LE with 003 or 003 Rack can act as Word clock master, or as a slave to Word clock supplied by an external device.

Pro Tools LE as Word Clock Master

003 or 003 Rack Word clock output is always active, letting Pro Tools supply Word clock to any connected devices that support standard Word clock.

To use Pro Tools LE as Word clock master:

1. Make sure all connections are correct between 003 or 003 Rack and your external devices.

2. Configure all external devices to slave to the Word clock coming from 003 or 003 Rack. (Be sure to match the sample rate setting of the Pro Tools session, and verify the termination requirements and other internal settings for the device; see the manufacturer’s documentation if you need more information on the particular requirements for your other equipment.)
3 Launch Pro Tools.
4 Choose Hardware > Setup.
5 Click the Clock Source pop-up menu and choose Internal.
6 Click OK.

Pro Tools LE as Word Clock Slave

In order to slave Pro Tools to an external Word clock source, you must configure Word clock as the Pro Tools Clock source, as follows:

To configure Pro Tools LE with 003 or 003 Rack as a Word clock slave:
1 Make sure all Word clock and audio connections are correct as described earlier in this section.
2 Make sure the external Word clock source is powered on, and configured to output 1x Word clock. (Be sure to verify any required termination; see the manufacturer’s documentation if you need more information on the particular requirements for your device.)
3 Launch Pro Tools.
4 Choose Hardware > Setup.
5 Click the Clock Source pop-up menu and choose Word Clock.
6 Click the Sample Rate pop-up menu and match the sample rate of the external Word clock source.
7 Click OK.

Using External Effects Devices

The 003 and 003 Rack can make dedicated connections to external analog or digital devices. You can send and return signals to analog devices using the analog inputs and outputs on the 003 and the 003 Rack. You can also send and return a digital signal to an external device that supports digital I/O (such as a reverb unit), and monitor the return by connecting its analog outputs to available inputs on 003 and 003 Rack.

When you use the digital inputs and outputs on your Pro Tools LE system as effects sends and returns to a digital effects device, Pro Tools LE should be the clock master in most cases. Set your digital effects device to accept an external digital clock so that it synchronizes to Pro Tools LE.

To connect an external analog device to your system:
1 Connect each input of the external signal processor to an available analog output on the 003 or 003 Rack.
2 Connect each output of the external signal processor to an available analog input on the 003 or 003 Rack.

💡 If you plan to use the external device as an Insert in Pro Tools, connect it to inputs and outputs of the same number (for example, Input 5 and Output 5) of 003 or 003 Rack.
To set up a send to an external digital effects device (digital sends/returns only):

1. Connect the digital inputs and outputs of the external signal processor to the appropriate digital connectors (the S/PDIF RCA connectors or the Optical ports) on 003 or 003 Rack.

2. In Pro Tools, choose Setup > Hardware.

3. Under Optical Format, do one of the following:
   - If the external effects device is a S/PDIF device and connected to the S/PDIF RCA jacks, select ADAT (if the selected sample rate is 44.1 or 48 kHz) or None (if the selected sample rate is 88.2 or 96 kHz). The RCA jack is only active when Optical S/PDIF is not enabled.
   - If the external effects device is a S/PDIF device and connected to the Optical ports, select S/PDIF.
   - If the external effects device is an ADAT Optical compatible device, select ADAT.

4. Choose Internal from the Clock Source pop-up menu.

5. Click the Sample Rate pop-up menu and select a sample rate. The sample rate of the Pro Tools session and external digital device must match. If necessary, change the sample rate of the digital device.

6. Click OK.

You can use the I/O Setup dialog (Setup > I/O) to label the inputs and outputs you are using in Pro Tools LE and identify them as inserts or sends when working in a session. See the Pro Tools Reference Guide for details.

---

Monitoring and Recording from Alternate Sources

003 and 003 Rack provide a pair of additional inputs for monitoring and recording from an external sound source such as a CD player or tape deck. This alternate input is equipped with 1/4-inch TRS connectors and is designed for input signals with a nominal operating level of +4 dBu.

To monitor an alternate sound source through 003 or 003 Rack Monitor Outputs:

1. Connect the outputs of the external device to the left and right Aux In connectors on the back panel of 003 or 003 Rack.

2. Route the signal to the Monitor Output by pressing the Aux In switch (located on the top panel of 003, and on the front panel of 003 Rack) so that it is enabled (lit).

3. If you want to monitor the signal through the Alternate Monitor Outputs, press the Alt CR switch. Any tracks within Pro Tools that are sent to the Monitor Outputs will not be heard.

4. Adjust Monitor Output or Headphone Output levels to audition the input.
To record an alternate sound source directly into Pro Tools:

1. Connect the outputs of the external device to the left and right Aux In connectors on the back panel of 003 or 003 Rack.

2. Route the signal directly to Inputs 7–8 in Pro Tools by pressing the Aux In to 7–8 switch (located on the top panel of 003, and on the front panel of 003 Rack) so that it is enabled (lit).

When the Aux In to 7–8 switch is enabled, Inputs 7 and 8 on the back panel are inactive. Also, because the signal can be monitored from Pro Tools, it no longer passes directly to the Monitor Outputs.

---

Recording from a Digital Device

If you are recording from an optical or S/PDIF device, you will need to select a Clock Source. In most cases, you will synchronize the Pro Tools clock to the external device.

If you are using an optical device for recording, you also need to set the Optical Format.

To configure Pro Tools LE for a digital source:

1. Connect an ADAT or Optical S/PDIF format device to the Optical In connector, or an RCA S/PDIF format device to the S/PDIF In connector on the back of the 003.

2. Choose Setup > Hardware.

3. Under Optical Format, do one of the following:
   - If the external digital device is a S/PDIF device and connected to the S/PDIF RCA jacks, select ADAT (if the selected sample rate is 44.1 or 48 kHz) or None (if the selected sample rate is 88.2 or 96 kHz). The RCA jack is only active when Optical S/PDIF is not enabled.
   - If the external digital device is a S/PDIF device and connected to the Optical ports, select S/PDIF.
   - If the external digital device is an ADAT Optical compatible device, select ADAT.

⚠️ You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time.

4. From the Clock Source pop-up menu, do one of the following:
   - If you are synchronizing the Pro Tools clock to the external device, select ADAT, RCA (S/PDIF) or Optical (S/PDIF), depending on where you connected your digital device.

⚠️ Your digital input device must be connected and powered on. If your input device is not powered on, leave the Clock Source set to Internal.

– or –

• Select Internal if you are synchronizing the external device to 003 or 003 Rack.

⚠️ You can use the I/O Setup dialog (Setup > I/O) to label the inputs and outputs you are using in Pro Tools LE and identify them as inserts or sends when working in a session. See the Pro Tools Reference Guide for details.
5 Click the Sample Rate pop-up menu and select a sample rate. The sample rate of the Pro Tools session and external digital device must match. If necessary, change the sample rate of the digital device.

6 Click OK.

Connecting a Recorder for Mixdowns

After you record and mix your sessions using 003 or 003 Rack, you may want to mix them down to a DAT, or other stereo 2-track recording device.

Connecting an Analog Deck

Connect your recorder’s inputs to the Alt Monitor Outputs (or any other output pair) on the back of the 003 or the 003 Rack. These outputs are 1/4-inch jacks. You may need adapter cables if your mixdown deck has RCA inputs.

Connecting a Digital Deck

If you have a DAT or other digital device that can receive S/PDIF digital audio data, connect it to the S/PDIF In and S/PDIF Out RCA jacks on the back of the 003 or the 003 Rack.

Connecting a Lightpipe-Compatible Device (ADAT)

To connect a Lightpipe-compatible device (ADAT) to 003 or 003 Rack:

1. Connect the Optical output on the ADAT to the Optical In port on the 003 or 003 Rack.
2. Connect the Optical input on the ADAT to the Optical Out port on the 003 or 003 Rack.

MIDI Connections

The MIDI ports on 003 and 003 Rack let you take advantage of all the MIDI features of Pro Tools LE, including recording and editing MIDI tracks.

If you need additional MIDI ports you can add a compatible MIDI interface (such as a Digidesign MIDI I/O).

To connect your MIDI device to 003 or 003 Rack:

1. Connect a standard 5-pin MIDI cable from the MIDI Out port of your device to the MIDI In port on the back panel of the 003 or 003 Rack.
2. Connect another MIDI cable from the MIDI In port of your device to one of the MIDI Out ports on the back panel of the 003 or 003 Rack.

The MIDI Out port can be selected in Pro Tools or a supported third party application.
**Monitoring MIDI Instruments with 003 or 003 Rack**

If you have a MIDI instrument that has analog outputs, you can connect it to the 003 or 003 Rack to monitor its output.

**To connect your MIDI instrument for monitoring in Pro Tools:**

- Connect the MIDI instrument’s audio output to a DI or Analog Input on the back panel of the 003 or 003 Rack.

*MIDI instrument audio outputs plugged into Analog Inputs 5–6*
chapter 10

Common Tasks with Pro Tools LE

This chapter provides instructions for common Pro Tools tasks.

For the most complete information on using Pro Tools, see the Pro Tools Reference Guide.

You can view an electronic PDF version of the Reference Guide by choosing it from the Pro Tools Help menu.

Recording a Pro Tools Session

Before you record with Pro Tools LE, you first create a Pro Tools session, then prepare an audio track for recording.

To create a Pro Tools session:

1. Verify the connections between your 003 or 003 Rack and your instrument or microphone.

For connection information, see Chapter 9, “Making Studio Connections.”

2. Launch Pro Tools.


4. In the New Session dialog, set the session parameters as needed, or leave them at their default settings. (For details on New Session settings, see the Pro Tools Reference Guide.)

5. Choose the audio drive where you want to save your session.

6. Type a name for your session.

7. Click Save.
To prepare an audio track for recording:

1. Choose Track > New.

2. Specify 1 Mono Audio Track in Samples if your source is mono, or 1 Stereo Audio Track in Samples if your source is stereo.

3. Click Create.

4. Make sure the Mix window is open by choosing Window > Mix.

5. In the Mix window, click the Audio Input Path selector on the new track.

6. From the pop-up menu, select the interface input you want to record. For example, select Analog 1 if your audio source is plugged into an Input 1 connector on the 003 or 003 Rack.

7. Play the instrument or sound source at the volume you will record.

8. Use the Gain controls to maximize the signal going into Pro Tools while avoiding clipping.

A mono instrument uses one input on the 003 or 003 Rack, and a stereo instrument uses two. Creating a stereo track in Pro Tools will not make a mono instrument into a stereo instrument. If a mono instrument is recorded on a stereo track, one of the sides of the stereo track will show no signal.

To record an audio track:

1. Click the track’s Record Enable button.

2. Choose Window > Transport to display the Transport window. Click Return to Zero to go to the beginning of the session.

3. Click Record in the Transport window to arm Pro Tools for recording. The Record button flashes red to indicate that Pro Tools is ready to record.

4. When you are ready to start recording, click Play or press the Spacebar.

5. Record your performance.
Click Stop in the Transport window or press the Spacebar when you are finished recording.

To play back a recorded track:
1. If the track's Record Enable button is lit, click on it to take it out of Record mode.
2. Click Play in the Transport window or press the Spacebar to start playback.
3. Click Stop in the Transport window or press the Spacebar to stop playback.

Importing Audio from a CD

To import audio from a compact disc:
1. Put the source CD into your computer's CD/DVD drive.
2. In Pro Tools, open the Workspace browser by choosing Window > Workspace. The Workspace browser is a window where you can find, audition, and manage your audio files.
3. In the Workspace browser, click the Audio CD icon to show the files on the CD.
4. Click the speaker icon in the Waveform column to audition the audio file. Press the Spacebar to stop playback.
5. Drag the audio file from the Workspace browser to the Track List in the Edit window to import the file to a new audio track.

To play back the new track:
1. In the Transport window, click Return to Zero to go to the beginning of the track.
2. Click Play in the Transport window to begin playback.
3. Click Stop in the Transport window or press the Spacebar to stop playback.
Creating an Audio CD from a Pro Tools Session

Pro Tools does not create audio CDs directly, but you can create stereo audio files from your Pro Tools sessions that can be used by most CD burning software.

**Bouncing Audio to Disk**

Use the Pro Tools Bounce to Disk feature to combine all your audible tracks into a single “master” audio file. After the new audio file has been bounced to disk, you can burn it to a CD.

If you are bouncing to 16-bit (CD resolution), you should use a dither plug-in on the main output. (For details, see the *Pro Tools Reference Guide*.)

**To bounce audio to disk:**

1. After you have finished recording and mixing a session in Pro Tools, select the length of the session in the timeline ruler (or on a track), plus an additional amount of time to avoid cutting off any reverb tails that might continue past the end of the last region.

2. Choose File > Bounce to > Disk.

3. In the Bounce Options dialog, choose Analog 1–2 as the Bounce Source.

4. Choose WAV (BWF) for the File Type.

5. Choose Stereo Interleaved for the Format.

6. Choose 16 for the Resolution and 44100 for the Sample Rate.

7. If you are changing the sample rate of the bounced file, choose a Conversion Quality setting. (For details, see the *Pro Tools Reference Guide*.)
Choose “Convert after Bounce,” and click Bounce.

In the Bounce dialog, give the bounce tracks a name and choose where they should be saved.

Click Save.

Pro Tools begins bouncing to disk. Pro Tools bounces are done in real time, so you hear audio playback of your mix during the bounce process (though you cannot adjust it).

Burning a CD

After the bounce is completed, you will have an audio file that is ready for burning onto a CD. Quit Pro Tools and launch any common CD burning application to burn your bounced mix to CD.

⚠️ Make certain that you configure your CD burning application to create an audio CD rather than a data CD.
Recording MIDI in a Pro Tools Session

What is MIDI?

MIDI (Musical Instrument Digital Interface) data is not audio, and has no sound. MIDI is a way for musical devices to communicate. MIDI is data that can trigger a MIDI device (such as a keyboard or software synthesizer).

In order to create or play a MIDI recording, you must have a MIDI controller or sound module (real or virtual) connected to the computer through a MIDI interface. Audio from your MIDI instrument can be monitored through the audio interface or sent to an external mixer.

Recording MIDI on an Instrument Track

Pro Tools Instrument tracks provide both MIDI and audio capabilities, so you can record MIDI and monitor audio from software and hardware instruments.

⚠️ To record or playback tracks using MIDI data, your Pro Tools system must be configured for MIDI. See Appendix A, “Configuring MIDI Studio Setup (Windows Only)” or Appendix B, “Configuring AMS (Mac OS X Only).”

To create an Instrument track and configure it for recording:

1. Choose Setup > MIDI > Input Devices and make sure your input device is selected in the MIDI Input Enable window, and click OK.

2. Choose Track > New and specify 1 Mono Instrument Track, then click Create.

3. Select View > Mix Window > Instruments to display the MIDI controls for the Instrument track.

4. At the top of the Instrument track in the Mix window, click the track’s MIDI Input selector and assign the device and channel to be recorded, or leave it set to All.
5 Do one of the following, depending on the type of instrument you are using:

- If you are using an instrument plug-in, click an Insert selector and insert the plug-in on the Instrument track. The track’s MIDI output is automatically assigned to the instrument plug-in.

- If you are using an external MIDI device, click the track’s MIDI Output selector (at the top of the Instrument track) and assign the device and channel to receive the MIDI output (the choices will vary depending on the device).

6 If you are using an external MIDI device and have connected its audio output to your audio interface for monitoring in Pro Tools, click the Input selector of the Instrument track and choose the corresponding audio input. (This step is not necessary if you are using an instrument plug-in.)

7 In the Mix Window, click the track’s Record Enable button to enable the Instrument track for MIDI recording.

8 Make sure Options > MIDI Thru is selected.

If your connected MIDI device does not appear, check that you have configured your computer and its MIDI settings. For more information, see Appendix A, “Configuring MIDI Studio Setup (Windows Only)” or Appendix B, “Configuring AMS (Mac OS X Only).”
9 Play some notes on your MIDI controller and look for the track's MIDI Velocity meter to move. Remember, MIDI is not audio, and the MIDI Velocity meter is not registering sound output, but MIDI activity.

10 Adjust the audio output level of the Instrument track with its Volume fader.

To record MIDI on the Instrument track:

1 Verify that the Instrument track you want to record to is record-enabled and receiving MIDI.

2 In the Transport window, click Return to Zero to start recording from the beginning of the session. You can also record to a selection in a track or from the cursor location in the Edit window.

3 Click Record in the Transport window.

4 Click Play in the Transport window or press the Spacebar to begin recording.

5 Play your MIDI controller or input device.

6 When you have finished recording, click Stop in the Transport, or press the Spacebar. The newly recorded MIDI data appears as a MIDI region on the track in the Edit window, as well as in the Region List.

To play back recorded MIDI data:

1 Click the track's Record Enable button to take the Instrument track out of Record mode.

2 In the Transport window, click Return to Zero to play back from the beginning of the track.

3 Click Play in the Transport window to begin playback. The recorded MIDI data plays back through the track's assigned instrument and channel.
In Pro Tools mode, the 003 can be used as a control surface for your Pro Tools sessions.

003 is in this mode when the 003 unit is connected to a computer and Pro Tools LE software is running.

If Pro Tools is running and no Pro Tools session is open, the unit normally displays “Open or create a new session.” When a session is being launched, the display changes to “Loading a session.”

If no session is open and a Workspace browser is open and being used for auditioning an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mirrors the on-screen controls. 003 faders, transport switches, rotary knobs, and switches control the corresponding elements in Pro Tools. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In Pro Tools mode, the Monitor section and MIDI I/O ports are available with a session open or closed.

To put 003 in Pro Tools mode:

1. Make sure the 003 unit is properly connected to the computer and powered on.
2. If Mute is disabled (unlit), enable Mute by pressing the Monitor Mute switch so that it is lit.
3. Launch Pro Tools LE and open or create a Pro Tools session.

Saving a Session

You can invoke the Save Session command from 003.

To save the current session:

1. Press the Save switch. The switch flashes to indicate that another press will result in a Save.
2. Do one of the following:
   - To save the session, press the Save switch a second time.
   - To cancel the save, press the ESC switch.
Working in Console View

Console View provides a global view of a given control type across the 003 (such as send A for the current bank of channels).

003 is in Console View when any of the Console View switches (Pan, Send, or Insert) is lit in the Console View section.

When you first open a Pro Tools session, the top row of the 003 is in Console View with the Pan switch enabled (lit). This default view is sometimes called the Home View.

Pan switch

Pan switch in Console View section

- In Console View, the touch-sensitive faders on 003 mirror the volume faders in Pro Tools. Fader assignments are shown on-screen in Pro Tools by blue outlines around the track names.
- In Console View, the LED rings surrounding the rotary encoders indicate either the pan position, the send level, or the insert control level for each channel, depending on which Console View switch is enabled (lit).

There are three Console Views, based on their corresponding switch name: Pan View, Send View, and Insert View.

Pan View Workflows

When the Pan switch is enabled (lit), 003 is in Pan View. This is the default View when you first open a Pro Tools session. In this view, you can use the rotary encoders to adjust pan on the current bank of tracks, select and rename tracks, and assign inputs or outputs in Assign mode.

For information on assigning inputs and outputs in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 92.

To adjust a track’s panning controls:

1. Press the Pan switch to put 003 in Pan View.
2. Do one of the following:
   - If the track is a stereo track, toggle the Meter switch to Left or Right.
   - or –
   - If the track is a mono track, toggle the Meter switch to Left.
3. Adjust a channel’s panning by turning its rotary encoder.

Selecting Tracks

To select a track:

1. Press the Pan switch to put 003 in Pan View.
2. Press a Channel Select switch that is unlit to select the track.

To select a range of tracks:

1. Press the Pan switch to put 003 in Pan View.
2. Press a Channel Select switch that is unlit to select the track.
3 Hold Shift (Add) and press the Channel Select switch for an unselected (unlit) track.

All tracks between the first track selected and the additional track will also be selected.

**To remove subsequent tracks in range of selected tracks:**

1. Press the Pan switch to put 003 in Pan View.
2. Hold Shift (Add) and press the Channel Select switch for a selected (lit) track in the middle (or beginning) of a range.

All tracks following the selected track will be deselected.

**To select all tracks:**

1. Press the Pan switch to put 003 in Pan View.
2. Hold Opt/Alt All and press the Channel Select switch for any unselected (unlit) track.

**To deselect all tracks:**

1. Press the Pan switch to put 003 in Pan View.
2. Hold Opt/Alt All and press the Channel Select switch for any selected (lit) track.

**To select or deselect noncontiguous tracks:**

1. Press the Pan switch to put 003 in Pan View.
2. Do one of the following:
   - In Pan View, hold Command/Ctrl and press the Channel Select switch for an unselected (unlit) tracks to select them.
   - or –
   - In Pan View, hold Command/Ctrl and press the Channel Select switch for any selected (lit) tracks to deselect them.

---

**Renaming Tracks**

**To rename a track:**

1. Press the Pan switch to put 003 in Pan View.
2. Double-press the Channel Select switch for the track you want to rename.
3. Enter the new name in the Track Name/Comments dialog.
4. Click Enter.

---

**Send View Workflows**

When the Send switch is enabled (lit), 003 is in Send View. In this view, you can adjust send level with the rotary encoders, toggle pre- and post-fader operation of sends, and assign sends in Assign mode.

For information on assigning sends in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 92.

**To display a Send position (A–J):**

1. Press the Send switch to put 003 in Send View.
2. Press the Insert/Send Position switch that corresponds to the send position that you want to adjust. The five Console View switches are dual-function (A/F, B/G, C/H, D/I, E/J). Press the switch to toggle from the current send to the corresponding one (such as Send A to F or Send F to A).

**To adjust send levels:**

1. Press the Send switch to put 003 in Send View.
2. Press the Insert/Send Position switch (A/F, B/G, C/H, D/I, E/J) that corresponds to the send position that you want to adjust.
3. Adjust a channel’s send level by turning its rotary encoder.
To toggle a send between pre- and post-fader operation:

1. Press the Send switch to put 003 in Send View.
2. Press the Channel Select switch under a send name to toggle its pre- and post-fader setting.

Insert View Workflows

When the Insert switch is enabled (lit), 003 is in Insert View. In this view, the LCD shows the names of currently-assigned inserts (hardware inserts or plug-ins) across all channel strips for a given insert position (Inserts A–E in Pro Tools).

If a hardware insert or plug-in is selected in Pro Tools, its name flashes in the LCD.

In this view, you can display inserts, plug-in controls, bypass plug-ins, and assign inserts in Assign mode.

For information on assigning inserts in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 92.

Working with Inserts

To display the inserts on an Insert position (A–E):

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Press the corresponding Insert/Send Position switch A–E.

The names of all inserts on that track are displayed in the LCD. (While the names of hardware I/O inserts are displayed, they have no editable parameters, so the Channel Select switches and the rotary encoders have no effect on them.)

To display the controls for a plug-in:

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Press the corresponding Insert/Send Position switch A–E.
3. Press the Channel Select switch under a plug-in name.

003 goes into Channel View and displays the plug-in’s controls across all channel strips. Controls are assigned to the rotary encoders. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

4. To display additional pages of plug-in controls (if any), press the Left and Right Page switches.

The Left or Right Page switch flashes when an additional page is available.

To bypass a plug-in:

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Hold Command/Ctrl and press the Channel Select switch under the plug-in name.

The LCD screen displays the name of bypassed plug-ins in all capital letters.
Working in Channel View

Channel View provides a way to temporarily focus on all the plug-ins, inserts or sends on a single channel.

003 is in Channel View when any of the first four Channel View Select switches (EQ, Dynamics, Insert, or Pan/Send) is lit in the Channel View section.

In Channel View, controls are displayed horizontally across the LCD and can be adjusted with the channel rotary encoders and switches. From this view, you can view and edit parameters for all the sends on a single track, or all the parameters of a single plug-in.

In Channel View, the touch-sensitive faders on 003 mirror the volume faders in Pro Tools.

In Channel View, the LED rings above the rotary encoders indicate values for the selected control, such as plug-in parameters, insert levels, or pan values and send levels, depending on which Channel View switch is lit.

EQ Plug-in Workflows in Channel View

When the EQ switch is enabled (lit), 003 identifies channels with equalizer plug-ins assigned to them by illuminating their Channel Select switches. If no EQ plug-ins are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display the controls for EQ plug-ins across all channel strips.

To display all EQ plug-ins on a track:

- Press the EQ switch to put 003 in Channel View.

To display the controls for an EQ plug-in:

1. Press the EQ switch to put 003 in Channel View.
2. Press a lit Channel Select switch.

Controls for the first EQ plug-in on that track are assigned to the rotary encoders and displayed in the LCD. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

3. To display additional pages of plug-in controls (if any), press the Left and Right Page switches.

The Left or Right Page switch flashes when an additional page is available.

To cycle through all the EQ plug-ins on a channel:

1. Press the EQ switch to put 003 in Channel View.
2. Hold the EQ switch and repeatedly press the track’s Channel Select switch.

If a plug-in window is open on-screen, it will update to reflect the plug-in selected on 003.

Dynamics Plug-in Workflows in Channel View

When the Dynamics switch is enabled (lit), 003 identifies channels with dynamics plug-ins (such as compressors or limiters) assigned to them by illuminating their Channel Select switches. If no dynamics plug-ins are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display the controls for dynamics plug-ins across all channel strips.

To display all Dynamics plug-ins on a track:

- Press the Dynamics switch to put 003 in Channel View.
To display the controls for a Dynamics plug-in:

1. Press the Dynamics switch to put 003 in Channel View.
2. Press a lit Channel Select switch.

Controls for the first Dynamics plug-in on that track are assigned to the rotary encoders and displayed in the LCD. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

3. To display additional pages of plug-in controls (if any), press the Left and Right Page switches.

💡 The Left or Right Page switch flashes when an additional page is available.

To cycle through all the Dynamics plug-ins on a channel:

1. Press the Dynamics switch to put 003 in Channel View.
2. Hold the Dynamics switch and repeatedly press the track’s Channel Select switch.

If a plug-in window is open on-screen, it will update to reflect the plug-in selected on the 003.

Insert Workflows in Channel View

When the Insert switch is enabled (lit), 003 identifies channels with any kind of insert assigned to them (software plug-ins or hardware I/O inserts) by illuminating their Channel Select switches. If no inserts are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display inserts or plug-in controls, bypass plug-ins, and assign inserts in Assign mode.

💡 For information on assigning inserts in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 92.

To display the inserts on a track:

1. Press the Insert switch (Channel View section) to put 003 in Channel View.
2. Press a lit Channel Select switch.

The names of all inserts on that track are displayed in the LCD. (While the names of hardware I/O inserts are displayed, they have no editable parameters, so the Channel Select switches and the rotary encoders have no effect on them.)

To display the controls for a plug-in:

1. Press the Insert switch (Channel View section) to put 003 in Channel View.
2. Press a lit Channel Select switch to display the inserts for the corresponding track.
3. Press the Channel Select switch under a plug-in name.

003 displays the plug-in controls across all channel strips. Controls are assigned to the rotary encoders. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

4. To display additional pages of plug-in controls (if any), press the Left and Right Page switches.

💡 The Left or Right Page switch flashes when an additional page is available.

To cycle through all the inserts on a channel:

- Hold the Insert switch and repeatedly press the track’s Channel Select switch.

To bypass a single plug-in:

1. Press the Insert switch (Channel View section) to put 003 in Channel View.
2. Press a lit Channel Select switch to display the inserts for the corresponding track.
3 Press the Channel Select switch under a plug-in name.

4 Press the Plug-In Master Bypass switch.

**To bypass all plug-ins on a channel:**

1 Press the Insert switch (Channel View section) to put 003 in Channel View.

2 Press a lit Channel Select switch to display the inserts for the corresponding track.

3 Press the Plug-In Master Bypass switch.

To bypass all plug-ins on a channel:

1 Press the Insert switch (Channel View section) to put 003 in Channel View.

2 Press a lit Channel Select switch to display the inserts for the corresponding track.

3 Press the Plug-In Master Bypass switch.

In mixed mode situations, where some plug-ins are bypassed and some are not, pressing the Master Bypass switch changes all plug-ins to bypassed. Press Master Bypass again to take all plug-ins out of bypass.

**Pan/Send Workflows in Channel View**

When the Pan/Send switch is enabled (lit), 003 identifies channels with sends assigned to them by illuminating their Channel Select switches. If no sends are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display sends, adjust send levels, and toggle pre- and post-fader operation.

**To display the sends on a track:**

1 Press the Pan/Send switch to put 003 in Channel View.

2 Press a lit Channel Select switch.

3 Do one of the following:
   • To display Sends A–E, press the Left Page switch.
   • To display Sends F–J, press the Right Page switch.

The LCD display for the first channel strip shows track pan position for that track. (If the track is a stereo track, you can toggle between left and right pan by pressing the Meter switch immediately to the right of the rotary encoders.)

The LCD display for channels 3–7 shows the send names. Their rotary encoders control the levels for the corresponding send.

The Channel Select switches on channels 3–7 toggle pre- and post-fader metering for the corresponding send.

**To adjust send levels for any of the sends on a single track:**

1 Press the Pan/Send switch in the Channel View switch section.

2 Press the Channel Select switch for the track with sends you want to view.

3 Adjust a channel’s send level by turning its rotary encoder.

**To adjust pan levels on a track that has sends:**

1 Press the Pan/Send switch in the Channel View switch section.

2 Press the Channel Select switch for the track with sends that has panning you want to adjust.

3 Do one of the following:
   • If the track is a stereo track, toggle the Meter switch to Left or Right.
   • If the track is a mono track, toggle the Meter switch to Left.

---

> Hardware I/O inserts cannot be bypassed in Pro Tools, so the Plug-in Master Bypass switch has no effect on them.
4 Adjust the track’s panning by turning the rotary encoder in the first fader strip.

**To toggle a send between pre- and post-fader operation:**
1. Press the Pan/Send switch to put 003 in Channel View.
2. Press a lit Channel Select switch to display the sends for the corresponding track.
3. Press the Channel Select switch under a send name to toggle its pre- and post-fader setting.

---

### Display Options in Console and Channel View

#### Displaying Full Names of Tracks, Insert Parameters, and Other Elements

Track names and other parameters displayed on the lower row of the LCD are abbreviated to six characters. Full names can be temporarily displayed on the top row of the LCD.

**To display full names of tracks and insert parameters, do one of the following:**
- In Pan View, hold Display and press the Channel Select switch for the track whose name you want to see displayed fully. The name displays on the left side of the top row of the LCD display.
  - or -
- In Insert View, when editing plug-in parameters, hold Display and press the Channel Select switch for the parameter whose name you want to see displayed fully. The name displays on the far right side of the top row of the LCD display.

#### Displaying Settings Instead of Track or Control Names

The lower row of the LCD shows track or control names by default. The display can be changed to temporarily show settings, or be reset to always show settings. The Display Mode switch flashes during a temporary display or when the LCD default has been reset to always show settings.

Depending on the current Console or Channel View, you can display insert, plug-in, or pan/send settings.

**To reset the LCD display to show settings for all views instead of track or control names:**
- Hold Command/Ctrl and press Display.

**To return the LCD display to its default state (showing track or control names in all views):**
- Press the flashing Display Mode switch.

**To temporarily display fader level in the LCD (Console Pan View):**
1. Press the Pan switch to put 003 in Pan View.
2. Hold the Display Mode switch. The lower row of the LCD shows fader levels for the current bank of channels (such as Channels 1–8).

*Fader levels can be adjusted with faders while the Display mode switch is pressed.*
To temporarily display send level in the LCD (Console Send View):

1. Press the Send switch to put 003 in Send View.
2. Hold the Display Mode switch. The lower row of the LCD shows send level for the current bank of sends (such as Send A for Channels 1–8).

*Send levels can be adjusted with rotary encoders (or with faders in Flip mode) while the Display mode switch is pressed.*

To temporarily display insert or plug-in parameters in the LCD (Console or Channel View):

1. Do one of the following:
   - Make sure the Insert switch is lit in the Console View section.
   - Make sure the EQ, Dynamics, Insert, or switch is lit in the Channel View section.
2. Press Channel Select for the an insert or plug-in that you want to display.
3. Hold the Display Mode switch. The lower row of the LCD shows the insert or plug-in settings.

*Parameters with ranges can be adjusted with rotary encoders (or with faders in Flip mode) while the Display mode switch is pressed. Controls such as On/Off cannot be changed when the Display mode switch is pressed.*

To temporarily display the channel pan setting and send levels in the LCD (Channel View):

1. Press the Pan/Send switch to put 003 in Channel View.
2. Press Channel Select for the channel with the pan and sends you want to display.

3. Hold the Display Mode switch. The lower row of the LCD shows the channel pan setting in the first fader strip and send levels for the currently-selected channel in fader strips 3–8.

*Pan settings and fader levels can be adjusted with rotary encoder while the Display mode switch is pressed.*

Navigating and Editing Values in Entry Fields

You can navigate and edit numerical values in Pro Tools windows (such as Selection Start, End, and Length, or Pre- and Post-Roll in the Edit or Transport windows) with the Arrow keys.

To navigate between fields in the Edit window, Transport window, or a plug-in window:

- Press the Left or Right Arrow key.

To change a value in a selected field:

- Press the Up or Down Arrow key.

Working with Tracks

Navigating the New Track Dialog when Creating a New Track

You can navigate the New Tracks dialog with the Arrow keys.

To increase or decrease the number of tracks:

- Press the Up or Down Arrow key.

To scroll through the track types:

- Hold Command/Ctrl and press the Up or Down Arrow key.
To scroll through the track formats:
- Hold Command/Ctrl and press the Left or Right Arrow keys.

Naming Tracks of Adding Track Comments

To open the Track Name/Comments dialog (to change a track’s name or comments):
- In Pan View, double-click the track’s Channel Select switch.

To close the Track Name/Comments dialog:
- In the Channel View section, press the ESC switch.

Navigating Track Name Field in the Track Name Dialog

You can move the cursor when you are naming tracks in the Track Name dialog.

To move the cursor while naming a track, do any of the following:
- Press the Left or Right Arrow key to move the cursor backward or forward through the name field.
- Press the Up or Down Arrow key to move the cursor to the beginning or end of the field.
- Hold Command/Ctrl and press the Up (or Left) or Down (or Right) Arrow key to move to the previous or next track name field.

Assigning Pro Tools Paths (Input, Output, Sends, Inserts)

Channel inputs, outputs, inserts, and sends can be assigned directly from the 003 in Assign mode.

Inputs and outputs are assigned in Pan View, sends are assigned in Send View, and inserts are assigned in Insert View.

Inputs and Outputs

To assign an input or output:
1. Press the Pan switch in the Console View section.
2. On the channel where you want to make the assignment, do one of the following:
   - To assign the output of a track, press its Channel Select switch for 2 seconds.
   - or –
   - To assign the input of a track, hold Shift and press the track’s Channel Select switch for 2 seconds.

The LCD changes to display the selected path and the Channel Select switch flashes.
3. If you are assigning a different input or output path type than the current type displayed on the LCD (such as a bus instead of an interface), do the following to select a new path type:
   - Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash (“-”) for no assignment, intrfc (interface), bus, and plug-in (inputs only).
   - Use the rotary encoder to scroll through the list of path types.
   - Press the flashing Channel Select switch to select the path type.
4. Use the rotary encoder to navigate through the available input or output paths in the submenu.
5 Do one of the following:
  • When the desired path is displayed, press the flashing Channel Select to confirm the assignment.

**If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.**

  • Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
  • Press the flashing ESC switch to cancel the assignment.

**To remove an input or output:**

1 On the channel where you want to remove the assignment, do one of the following:
  • To remove the input of a track, hold Shift and press the track’s Channel Select switch for 2 seconds.
  – or –
  • To remove the output of a track, press its Channel Select switch for 2 seconds.

2 For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning inputs or outputs. This menu includes a dash (“—”) for no assignment, intrfc (interface), and bus.

3 Turn the rotary encoder counter-clockwise until the dash (“—”) for no assignment is visible.

4 Do one of the following:
  • Press the flashing Channel Select switch to confirm the removal.
  – or –
  • Press the flashing ESC switch to cancel the removal and restore the assignment.

**Sends**

**To assign a send:**

1 Press the Send switch in the Console View section.

2 On the channel where you want to make the assignment, press its Channel Select switch for 2 seconds.

The LCD changes to display the bus or output currently assigned to the selected send, and the Channel Select switch flashes.

3 If you are assigning a different send path type than the current type displayed on the LCD (such as a bus instead of an interface), do the following to select a new path type:
  • Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash (“—”) for no assignment, intrfc (interface), and bus.
  • Use the rotary encoder to navigate through the list of path types.
  • Press the flashing Channel Select switch to select the path type.

4 Use the rotary encoder to navigate through the available send paths in the submenu.

5 Do one of the following:
  • Press the flashing Channel Select to confirm the assignment.

**If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.**

  • Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
  • Press the flashing ESC switch to cancel the assignment.
To remove a send:

1. On the channel where you want to remove the assignment, press its Channel Select switch for 2 seconds.

2. For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning sends. This menu includes a dash (“–”) for no assignment, intrfc (interface), and bus.

3. Turn the rotary encoder counter-clockwise until the dash (“–”) for no assignment is visible.

4. Do one of the following:
   - Press the flashing Channel Select switch to confirm the removal.
   - or –
   - Press the flashing ESC switch to cancel the removal and restore the assignment.

Inserts

To assign an insert:

1. Press the Insert switch in the Console View section.

2. On the channel where you want to make the assignment, press its Channel Select switch for 2 seconds.

   The LCD changes to display the plug-in or output currently assigned to the selected insert, and the Channel Select switch flashes.

3. If you are assigning a different insert path type than the current type displayed on the LCD, do the following to select a new path type:
   - Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash (“–”) for no assignment, plugin (plug-in), and I/O.
   - Use the rotary encoder to navigate through the list of path types.
   - Press the flashing Channel Select switch to select the path type.

4. If you are assigning a plug-in insert, navigate down through the submenu levels as necessary.
   - Use the rotary encoder to navigate through the list of plug-in submenus.
   - Press the flashing Channel Select switch to select the submenu.
   - Repeat these steps if necessary, to navigate through additional plug-in submenu levels.

   You can hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.

The types of plug-in submenus is determined by the Organize Plug-in Menus preference in Pro Tools. See the Pro Tools Reference Guide for more information.

5. When the desired submenu path is displayed, use the rotary encoder to navigate through the available insert paths in the menu.

6. Do one of the following:
   - Press the flashing Channel Select to confirm the assignment.

   If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.

   - Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
   - Press the flashing ESC switch to cancel the assignment.
To remove an insert:

1. On the channel where you want to remove the assignment, press its Channel Select switch for 2 seconds.

2. For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning inserts. This menu includes a dash (“–”) for no assignment, plugin (plug-in), and I/O.

3. Turn the rotary encoder counter-clockwise until the dash (“–”) for no assignment is visible.

4. Do one of the following:
   - Press the flashing Channel Select switch to confirm the removal.
   - or –
   - Press the flashing ESC switch to cancel the removal and restore the assignment.

---

Working with Output Windows

Output windows for tracks and sends can be opened or closed, and the track output can be made active or inactive.

Track Output Windows

To open (or close) a track Output window:

1. Press the Pan switch to put 003 in Pan View.

2. Hold the Ctrl/Win switch and press the Channel Select switch for a track to open (or close) its Output window.

To open (or close) multiple track Output windows:

- In Pan View, hold Shift (Add)+Ctrl/Win and press the Channel Select switch for each track whose window you want to open (or close).

To make a track’s output inactive:

- In Pan View, hold Command/Ctrl+Ctrl/Win and press the Channel Select switch for a track to make it output inactive.

Send Output Windows

To toggle a send’s pre- and post-fader operation:

1. Press the Send switch to put 003 in Send View.

2. Press a Channel Select switch for the send whose pre- and post-fader setting you want to change. When you release the Channel Select switch, the LCD shows the new setting.

To mute or unmute a send:

1. Press the Send switch to put 003 in Send View.

2. Hold Command/Ctrl and press the Channel Select switch for a send on a track to mute or unmute it. When the send is muted, its name appears in all caps in the LCD.

To open (or close) a send’s Output window:

1. Press the Send switch to put 003 in Send View.

2. Hold Ctrl/Win and press the Channel Select switch for a track to open (or close) its Output window.

To open (or close) multiple send Output windows:

1. Press the Send switch to put 003 in Send View.

2. Hold Shift (Add) and Ctrl/Win and press the Channel Select switch for each track whose window you want to open (or close).
**Recording**

**To enable or disable tracks for recording:**

1. Press the Rec Arm switch so that it is enabled (flashing). When the Record Arm function is enabled, “Record Arm” is displayed in the top row of the LCD display.

2. Do one of the following:
   - To enable a track for recording, press the Channel Select switch for the track you want to enable for recording. When a track is armed for recording, its Channel Select switch flashes. During recording, its Channel Select switch is lit continuously.
   - or –
   - To disable a track for recording, press the Channel Select switch for the track you want to disable for recording.

3. To deactivate the Record Arm function, press the Record Arm switch a second time (or press the ESC switch).

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.

**Navigating in the Edit Window**

**Zooming in the Edit Window**

You can zoom in or out in the Edit window, in order to increase or decrease the waveform or MIDI resolution.

**To zoom in horizontally for all tracks:**

1. Press the Zoom switch.

2. Press the Right Arrow key.

**To zoom out horizontally for all tracks:**

1. Press the Zoom switch.

2. Press the Left Arrow key.

**To zoom in vertically for all tracks:**

1. Press the Zoom switch.

2. Press the Up Arrow key.

**To zoom out vertically for all tracks:**

1. Press the Zoom switch.

2. Press the Down Arrow key.

**To continuously zoom in or out horizontally for all tracks:**

- Hold the Nudge switch and rotate the inner Jog wheel clockwise or counter-clockwise.

**To continuously zoom in or out vertically for all tracks:**

- Hold Shift (Add)+Opt/Alt (All)+Nudge and rotate the inner Jog wheel clockwise or counter-clockwise.

**Navigating with the Shuttle/Jog Wheel**

**Shuttle Mode**

**To play forwards at a variable rate:**

- Rotate the outer Shuttle ring clockwise.

**To play backwards at a variable rate:**

- Rotate the outer Shuttle ring counter-clockwise.
Jog Mode

To move the Transport (or cursor) forwards:
- Rotate the inner Jog wheel clockwise.

To move the Transport (or cursor) backwards:
- Rotate the inner Jog wheel counter-clockwise.

Page Scrolling the Edit Window

To scroll the Edit window one page at a time:
1. Press the Bank, Nudge, or Zoom switch.
2. Hold Command/Ctrl and press the Left or Right Arrow key.

Moving the Cursor and Making Selections

To move the cursor or Edit selection up or down one track:
1. Press the Bank or Nudge switch.
2. Press the Up or Down Arrow key.

To extend an Edit selection up or down one track:
1. Press the Bank or Nudge switch.
2. Hold Shift and press the Up or Down Arrow key.

Setting Selection Start and End Points

You can make a selection in the Edit window: during playback with the Arrow keys.

To make a selection while playing:
1. Make sure to select Options > Link Timeline and Edit Selection.
2. Click in the track near where you want to make the selection.
3. Start playback.
4. Press the Down Arrow key at the point where you want the selection to begin.
5. Press the Up Arrow key at the point where you want the selection to end.

General Editing

Setting Track Controls to Defaults

The Default switch is used to reset a fader (or fader-mapped plug-in parameter) to its default setting.

To set a channel's fader or plug-in parameter to its default setting:
- Hold the Default switch and press the Channel Select switch on a track.

To set all channel faders or plug-in parameters to their default settings:
- Hold the Default and Opt/Alt (All) switches and press the Channel Select switch on a track.

Undoing Pro Tools Operations

You can undo Pro Tools operations from 003. (See the Pro Tools Reference Guide for details on multiple undo capabilities.)

To undo an action:
- Press the Undo switch.

To redo an action:
- Hold Shift (Add) and Command/CtrI and press the Undo switch.
Working With Memory Locations

Pro Tools Memory Locations (Markers) can be created directly from 003 during playback or while the Transport is stopped.

To create a Memory Location:
1. Cue Pro Tools to the desired location, or begin playback.
2. At the desired location, press Enter (located among the switches above and to the left of the Navigation keys).
3. Use the mouse to configure the Memory Location dialog onscreen.
4. Press Enter again to save, or press Undo to cancel.

To open (or close) the Memory Location window:
- Hold Shift (Add) and press the Mem Loc switch.

To display Memory Locations:
1. Press the Mem Loc switch. When the switch is enabled (flashing), the LCD shows the first eight Memory Locations in the bottom row of the LCD display.
2. To display additional pages of Memory Locations (if any), press the Left and Right Page switches.

2. To display additional pages of Memory Locations (if any), press the Left and Right Page switches.
3. Do one of the following:
   - Press the Channel Select switch that corresponds to the Memory Location.
   - To return to the previous view without selecting a Memory Location, press Mem Loc again, or any of the Console or Channel View switches.

Controlling Track Display on the Control Surface

Using Flip Mode

In Flip mode, control assignments are transferred from the rotary encoders to the corresponding channel faders.

To transfer controls from the rotary encoders to the touch-sensitive faders:
- Press the Flip switch. This switch flashes when Flip mode is activated.

To exit Flip mode (and transfer controls from faders back to the rotary encoders):
- While in Flip mode, press the Flip switch.

Flip Mode Views

There are several types of Flip mode, depending on the view.

Send Flip Mode When you are in Console Send View, the Flip switch moves the send level controls to the channel faders, and the send pan controls to the rotary encoders. The LCD shows the selected send (A–E, or F–J) for each channel.
In addition, the Mute switch controls Send mute, whereas the Solo switch continues to control the track’s output muting and the Select switch continues to control Send Pre/Post status.

For mono tracks with stereo sends, only the left pan indicator shows a pan position; the right pan indicator is inactive.

For stereo tracks with stereo sends, you can control either the left or right send pan from the rotary encoder.

**To assign a stereo send channel to a rotary encoder:**

- While in Send Flip mode, press the Meter switch immediately to the right of the rotary encoders and select Left or Right.

Both the LCD and the Meter Mode LEDs indicate whether the left or right pan position is displayed. The rotary encoder LEDs show pan positioning.

**Plug-In Flip Mode** When you are in Channel View (or Console Insert View) and working with a plug-in insert, the Flip switch moves any plug-in control assignments from the rotary encoders to the faders, allowing you to use the touch-sensitive faders to edit and automate plug-in control values. The types of plug-in controls depend on the particular plug-in you are using.

See “Working in Channel View” on page 87 for more details on working with pan controls and sends in Channel View.

**Pan/Send Flip Mode** When you are in Channel View and working with the pan and send assignments on a channel, the Flip switch moves the send level controls to channel faders 3–7, and the send pan controls to rotary encoders 3–7. (The first Channel’s LCD display and rotary encoder continue to show track pan position for that track.)

In this mode, the Channel Select switches toggle pre- and post-fader metering for the corresponding send.

For stereo tracks with stereo sends, you can control either the left or right send pan from the rotary encoder. See “Send Flip Mode” on page 98.

**Banking Channels on 003**

**To move the display of tracks on 003 forward or backward eight channels at a time:**

1. Press the Bank switch.
2. Press the Left or Right Arrow key.

**To move the display of tracks on 003 forward or backward one channel at a time:**

1. Press the Nudge switch.
2. Press the Left or Right Arrow key.

**To scroll the display of tracks on 003 forwards**

- Hold the Nudge switch and rotate the inner Jog wheel clockwise to scroll tracks to subsequent faders.

**To scroll the display of tracks on 003 backwards:**

- Hold the Nudge switch and rotate the inner Jog wheel counter-clockwise to scroll tracks to previous faders.

See “Working in Channel View” on page 87 for more details on working with pan controls and sends in Channel View.
Banking Master Faders

To bank all Master Fader tracks in the current session to the right-hand side of the control surface:
- Press the Mstr Fader switch so that its LED is flashing.

To return the control surface to the previous view:
- Press the Mstr Fader switch so that its LED is unlit.

Muting Fader Movement

Because 003 faders are motorized, they move to follow automation when playing back and recording (when the track is set to an automation read or write mode, and not Off). During critical listening passes, the sound of the fader motors and their automated movements may be distracting. You can temporarily shut off (or mute) motorized fader movement using the Fader Mute switch.

To mute fader movement:
- Press the Fader Mute switch so that its LED is flashing.

To unmute fader movement:
- Press the Fader Mute switch so that its LED is unlit.

Working with Automation

The Automation mode can be set from 003 for a single track, all selected tracks, or all tracks in the session. You can also suspend automation globally.

To set the Automation Mode for a single track:
- Hold an Automation Mode switch and press the Channel Select switch on a track.

To set the Automation Mode for all tracks
- Hold the Option/Alt All and press an Automation Mode switch.

To set the Automation Mode for all selected tracks
- Hold the Option/Alt (All)+Shift (Add) and press an Automation Mode switch.

To suspend automation for all tracks:
- Press the Suspend switch.

To return all tracks to their previous Automation modes, press the Suspend switch again.
003 Top Panel Shortcuts

003 provides shortcuts for many common 003 tasks in Pro Tools mode.

**Display Options**

**Display Options Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display full name of a track in top LCD row (Pan mode)</td>
<td>Hold Display and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Display full name of insert parameter (Insert View, Plug-in Edit mode)</td>
<td>Hold Display and press Channel Select switch for an insert</td>
</tr>
<tr>
<td>Reset lower row of LCD display to show fader values (Pan View), send gain levels (Send View), and pan and send levels (Pan/Send Channel View)</td>
<td>Command/Ctrl+Display</td>
</tr>
</tbody>
</table>

**Track Shortcuts**

**Track Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select or deselect contiguous tracks (Home View or Pan View)</td>
<td>Hold Shift (Add) and press Channel Select switch for each track</td>
</tr>
<tr>
<td>Select or deselect all tracks (Home View or Pan View)</td>
<td>Hold Alt and press Channel Select switch for any track</td>
</tr>
<tr>
<td>Select or deselect noncontiguous tracks (Pan View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for each track</td>
</tr>
<tr>
<td>Open track’s Track Name/Comments dialog (Home View or Pan View)</td>
<td>Double-click track’s Channel Select switch</td>
</tr>
<tr>
<td>Scroll track types in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Up or Down Arrow key</td>
</tr>
<tr>
<td>Scroll track formats in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Left or Right Arrow key</td>
</tr>
<tr>
<td>Move to previous track in Track Name/Comments dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Up or Left Arrow key</td>
</tr>
</tbody>
</table>
**Track Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to next track in Track Name/Comments dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Down or Right Arrow key</td>
</tr>
<tr>
<td>Scroll Timebase formats in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Ctrl/Win+Opt/Alt All+Up or Down Arrow key</td>
</tr>
<tr>
<td>Add or Remove entries in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Shift (Add)+Up or Down Arrow key</td>
</tr>
<tr>
<td>Make track’s output inactive or active (Pan View)</td>
<td>Hold Command/Ctrl+Ctrl/Win and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Mute or unmute send (Send View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track send</td>
</tr>
<tr>
<td>Make send output inactive or active (Pan View)</td>
<td>Hold Command/Ctrl+Ctrl/Win and press Channel Select switch for a track send</td>
</tr>
</tbody>
</table>

**Input Assign Mode Shortcuts**

**Input Assign Mode Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Input Assign mode</td>
<td>Hold Shift and press Channel Select switch of a track for two seconds</td>
</tr>
<tr>
<td>Display all input, output, send, or insert menus (Assign mode)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Remove an insert (Console or Channel Insert View, and if applicable, EQ or Dynamics View)</td>
<td>Hold Default and press Channel Select switch for an insert</td>
</tr>
</tbody>
</table>

**Output Window Shortcuts**

**Output Window Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close track Output window (Pan View)</td>
<td>Hold Ctrl/Win and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Open or close multiple track Output windows (Pan View)</td>
<td>Hold Ctrl/Win+Shift (Add) and press Channel Select switch for each track</td>
</tr>
</tbody>
</table>
## Output Window Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close send Output window (Send View)</td>
<td>Hold Ctrl/Win and press Channel Select switch for a track send</td>
</tr>
<tr>
<td>Open or close multiple send Output windows (Pan View)</td>
<td>Hold Ctrl/Win+Shift (Add) and press Channel Select switch for each track send</td>
</tr>
</tbody>
</table>

## Plug-in Shortcuts

### Plug-in Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close a plug-in window (Console or Channel Insert View)</td>
<td>Hold Ctrl/Win and press Channel Select switch for a plug-in</td>
</tr>
<tr>
<td>Inactivate or activate a plug-in (Console or Channel Insert View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a plug-in</td>
</tr>
<tr>
<td>Bypass or unbypass plug-in (Console or Channel Insert View, and if applicable, EQ or Dynamics View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track plug-in</td>
</tr>
</tbody>
</table>

## Navigation Shortcuts

### Navigation Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Edit window one pane at a time (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+ Left or Right Arrow key</td>
</tr>
</tbody>
</table>

## Editing Shortcuts

### Editing Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend cursor or selection (Bank or Nudge mode)</td>
<td>Shift (Add)+Up or Down Arrow key</td>
</tr>
<tr>
<td>Reset fader to is default setting</td>
<td>Hold Default and press Channel Select switch for a track</td>
</tr>
</tbody>
</table>
### Editing Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset all faders or plug-in parameters to their factory default settings (Plug-in Edit mode)</td>
<td>Hold Default+Opt/Alt All and press Channel Select switch for a track or plug-in</td>
</tr>
<tr>
<td>Redo an edit (Edit &gt; Redo in Pro Tools)</td>
<td>Command/Ctrl+Shift (Add)+Undo</td>
</tr>
</tbody>
</table>

### Memory Location Shortcuts

#### Memory Location Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a Marker Memory Location</td>
<td>Hold Mem Loc switch and press Channel Select for a Memory Location</td>
</tr>
<tr>
<td>Open or close the Marker Memory Location dialog</td>
<td>Shift+Mem Loc</td>
</tr>
</tbody>
</table>

### Automation Shortcuts

#### Automation Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Automation mode for a track</td>
<td>Hold Automation switch (Write, Touch, Latch, Read, or Off) and press Channel Select track</td>
</tr>
<tr>
<td>Set Automation mode for all tracks</td>
<td>Hold Option/Alt All and press Automation switch (Write, Touch, Latch, Read, or Off)</td>
</tr>
<tr>
<td>Set Automation mode for all selected tracks</td>
<td>Hold Option/Alt All+Shift (Add) and press Automation switch (Write, Touch, Latch, Read, or Off)</td>
</tr>
</tbody>
</table>
Appendix A: Configuring MIDI Studio Setup (Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.

Interface Controls

Create This button adds a new instrument to the Instrument Name list.

Delete This button deletes the instrument or instruments selected in the Instrument Name list.

Import This button lets you import an existing MIDI Studio Setup file.

Export This button lets you export the current MIDI Studio Setup file.
Show Duplicate Emulated Ports  If you are using a
MIDI interface that supports timestamping
(such as MIDI I/O), when the Show Duplicate
Emulated Outputs option is selected, the MIDI
Studio Setup window shows both the DirectMu-
sic time-stamped output ports, and non-
stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load
or unload their drivers unless you quit and
re-launch Pro Tools. Check the documenta-
tion that came with your MIDI interface for
more information.

Instrument List

The Instrument list contains all the currently
defined instruments. Selecting an instrument in
the list displays that instrument’s properties in
the Properties section of the window.

Properties Section

The Properties section lets you edit information
for new instruments, or instrument currently se-
lected in the Instrument list.

When a previously defined instrument is se-
lected in the Instrument list, the Properties sec-
tion changes to reflect the properties of the se-
lected instrument.

To define an instrument with MIDI Studio Setup:

1  Choose Setup >MIDI > MIDI Studio.
2  Click Create.
3  In the Instrument Name field, type the name
   of your instrument, and press enter.
4  Set a manufacturer and model for the new de-
   vice from the corresponding pop-up menus. If
   the Manufacturer and Model pop-up menus do
   not provide a name for your particular device,
   choose None.
5  From the Input pop-up menu, choose the in-
   put port on your MIDI interface that is con-
   nected to the MIDI Out of your instrument.
6  From the Output pop-up menu, choose the
   output port on your MIDI interface that is con-
   nected to the MIDI In of your instrument.
7  Enable the appropriate MIDI channels (1–16)
   for the Send Channels and Receive Channels
   options (These determine which channels send
   and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-de-
finable instrument name for the currently se-
lected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list
of MIDI equipment manufacturers. This list is
derived from the XML-based MIDI device files.

For more information, see “MIDI Patch
Name Support” on page 107.
Appendix A: Configuring MIDI Studio Setup (Windows Only)

Model

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

For more information, see “MIDI Patch Name Support” on page 107.

Input Port

The Input Port pop-up menu displays a list of available MIDI interface input ports. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input selector.

Output Port

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input selector.

Send Channels

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

Receive Channels

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

MIDI Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for you external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

To import MIDI patch names into Pro Tools:

1 Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 105).

2 Verify the MIDI track’s output is correctly assigned to the MIDI device.

3 Click the MIDI track’s Patch Select button.
4 In the Patch Select dialog, click the Change button.

5 In the Open dialog, navigate to Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6 Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

To clear patch names:
- In the Patch Select dialog, click the Clear button, and click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third party patch librarian and editor software to create your own custom patch names.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.
Appendix B: Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Applications/Utilities).
   - or –
   - In Pro Tools, choose Setup > MIDI > MIDI Studio.

2. Click the MIDI Devices tab. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1. Select the external device icon and click Show Info (or double-click the new device icon).

```
External Device Icon
```

2. Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

```
Naming a new MIDI device
```

For Manufacturer and Model names, AMS refers to one or more files with the suffix ".middev" in the directory Root/Library/Audio/MIDI Devices. Pro Tools installs a file that contains information for many commercially available MIDI devices, named “Digidesign Device List.middev.” If the Manufacturer or Model names for any of your external MIDI devices is not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing the .middev file in any text editor (such as TextEdit).
3 Click the More Properties arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Click OK.

The device names you enter appear as MIDI input and output choices in Pro Tools.

To use your own custom icons, you can place TIFF image files in /Library/Audio/MIDI Devices/Generic/Images, and they will appear as choices in the AMS device window.
**Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Setup” on page 109).
2. Verify the MIDI track’s output is correctly assigned to the MIDI device.
3. Click the MIDI track’s Patch Select button.
4. In the Patch Select dialog, click the Change button.
5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.
6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:
- In the Patch Select dialog, click the Clear button, and click Done.

> MIDI patch name files (.midnam) can be edited in any text editor, or you can use third party patch librarian and editor software to create your own custom patch names.
Utility Mode (003 Only)

003 is in this mode when the Utility switch is enabled (flashing). In Utility mode, you can run pre-programmed diagnostic tests of the 003 unit. The Utility switch is unavailable in Pro Tools mode.

Utility functions include the following:

- Software and firmware version display
- Tests for the LCD display, LEDs, switches, rotary encoders, faders, MIDI, and audio.
- Return MIDI Maps to factory default settings. See the 003 MIDI Mode Guide.

⚠️ Utility mode is not available in Pro Tools mode. Pro Tools must be closed to enable Utility mode.

Navigating Utility Mode

When running a Utility mode test, you can return to the previous Utility page or exit the test at anytime.

To return to the previous Utility page:

- Press the flashing Display Mode switch.

To exit a test:

- Press the flashing ESC switch or Display Mode switch.

Exiting Utility Mode

To exit Utility mode:

1. If a test is running, press ESC or Display Mode to exit the test.
2. Press the flashing Utility mode switch.

Accessing Utility Mode

To enter Utility mode:

1. If Pro Tools is running, choose File > Exit (Windows) or Pro Tools > Quit (Mac).
2. Press the Utility switch.

The Utility switch flashes when it is enabled.

The LCD shows the top level Utility functions across the lower row: Version and Test. The corresponding Channel View switches flash for each available Utility option.
**Viewing Firmware Version Data**

This Utility function lets you check the current firmware version and other statistics useful when upgrading, or when contacting technical support.

**To display firmware version data:**
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select Version by pressing the flashing EQ switch.

The LCD shows version information about various components of the unit.

3. To exit and return to the previous Utility mode display, press the flashing Display Mode switch.

**LCD Display Test**

Use this test to assess the performance of the LCD.

**To test the LCD:**
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the LCD test by pressing the flashing Dynamics switch.

The 003 automatically scrolls all of its character sets across the LCD display.

4. To stop scrolling and quickly tell if any area of the display is damaged, press and hold any switch except for the Display Mode switch.

5. Do one of the following:
   - To return to the previous Utility page, press the flashing Display Mode switch.
   - or –
   - To exit the test at anytime, press the flashing ESC switch or Display Mode switch.

**LED Tests**

Use this test to display all LEDs simultaneously or cycle through the LEDs.

**To test LEDs:**
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the LED menu by pressing the flashing Insert switch.

4. Do one of the following
   - To display all LEDs, press the flashing Dynamics switch.
   - or –
   - To cycle through all the LEDs, press the flashing Insert switch.

5. To exit the test at anytime, press any switch.
Switch Test

Use this test to evaluate the performance of switches.

To test switches:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Switch test display by pressing the flashing Pan/Send switch.

4. Press any top panel switch to test it. The LCD shows the name, region and number for each switch as you test it.

5. Do one of the following:
   - To display all LEDs, press the flashing Dynamics switch.
   - or -
   - To cycle through all the LEDs, press the flashing Insert switch.

6. To exit the test at anytime, press the Display Mode switch.

Encoder Test

Use this test to evaluate the performance of the rotary encoders or the Jog/Shuttle wheel.

To test the encoders:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Enter the Encoder test by pressing the flashing Page Left switch.

4. Rotate any encoder (or the Jog/Shuttle wheel) to test it. Encoder value is displayed in the LCD while testing.

5. To exit the test at anytime, press the Display Mode switch.

Fader Tests

Utility mode provides tests for fader and group performance. You can use these routines to troubleshoot the mechanical elements of the faders.

Automated Fader Tests

These automated fader tests check fader performance. You can use these routines to troubleshoot the mechanical elements of the faders.

To test fader resolution:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Fader menu by pressing the flashing Page Right switch.

4. Select one of the basic automated fader tests: Triang, Sine, or Step.

5. To exit the test at anytime, press any switch.

⚠️ Do not touch the faders during a Fader test.

The faders will automatically move in a triangular, sine, or step pattern, as selected.
**Fader Group Test**

To test fader group resolution:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Fader menu by pressing the flashing Page Right switch.

4. Enter the Group test by selecting the flashing Page Left switch.

5. One by one, touch and move each fader. The other seven faders follow, and the LCD shows the resolution for each fader as they move through their range so you can compare fader performance as both a group master and slave.

6. To exit the test at anytime, press the flashing Display Mode switch.

**Touch Test**

This test lets you test the touch sensitivity of each fader. The LCD display shows when a fader is touched and what frequency the fader is currently recognizing. The fader frequency value is updated in real time.

To test the touch sensitivity of the faders:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Fader menu by pressing the flashing Page Right switch.

4. Enter the Touch test by selecting the flashing Page Right switch.

5. One by one, touch and move each fader. The LCD shows the resolution for each fader as they move through their range.

6. To exit the test at anytime, press the flashing Display Mode switch.

**Vegas Mode**

Vegas mode randomly lights every switch, meter, and display on the unit, and runs the faders in sine wave mode.

To enter Vegas mode:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Start “Vegas” mode by pressing the flashing Page Right switch.

4. To exit the test at anytime, press any switch.
MIDI Test

003 includes a MIDI loopback test to check MIDI input and output connections. A standard 5-pin MIDI cable is required.

To test MIDI input and output connections:

1. On the back of the 003, connect a standard 5-pin MIDI cable from the MIDI In port to the MIDI Out 1.

2. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

3. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

4. Press the ESC switch to toggle to the second page of Utility tests.

5. Start the “MIDI” test by pressing the flashing Dynamics switch.

6. Press the EQ switch to begin testing MIDI Out 1.

If data is received on the MIDI jack, the LCD shows “Pass.” If DATA is not received, the LCD shows “Fail.”

7. Connect a standard 5-pin MIDI cable from the MIDI In port to the MIDI Out 2 and repeat the test to check MIDI Out 2.

8. When finished, press the flashing Display switch.

Audio Test

003 includes audio loopback tests (see “Routing Path for Audio Tests” on page 118) to check various audio connections. For each test, a valid audio source and external sound system must be set up for the specific inputs or outputs being tested. See “Making Studio Connections” on page 61 for information on connecting devices.

Cables corresponding to each connector type are required. See “003 and 003 Rack Back Panels” on page 55 for cabling requirements for each connector.

When testing a digital input, the digital source must be connected to one of the 003 digital outputs and the source must be configured to clock to the 003 digital output.

All tests run at 44.1 kHz.
Testing Audio Connections

To test audio connections:

1. Make the necessary connection for the input and output you are testing. See “Routing Path for Audio Tests” on page 118.

2. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

3. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

4. Press the ESC switch to toggle to the second page of Utility tests.

5. Enter “Audio” test mode by pressing the flashing Inserts (Channel View) switch.

6. Begin an Audio test by pressing the Channel View switch that corresponds to the test you want to run.

7. For the S/PDIF In and Out tests, press the Dynamics or Insert switch repeated times to toggle through the different test, or to test all of the S/PDIF routing paths.

8. When finished, press the flashing Display switch.

Routing Path for Audio Tests

<table>
<thead>
<tr>
<th>Audio Test</th>
<th>Routing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intl</td>
<td>Internal loopback of all analog and digital I/O channels (Analog Input 1 to Analog Output 1, Analog Input 2 to Analog Output 2, and so on).</td>
</tr>
<tr>
<td>Sgnl</td>
<td>003 generates a 440 Hz sine wave on all analog and digital outputs. Level is adjustable from 0 dB to –42 dB with the rotary encoder in the second fader strip.</td>
</tr>
<tr>
<td>SpIn 1/2</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 1–2.</td>
</tr>
<tr>
<td>SpIn 3/4</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 3–4.</td>
</tr>
<tr>
<td>SpIn 5/6</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 5–6.</td>
</tr>
<tr>
<td>SpIn 7/8</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 7–8.</td>
</tr>
<tr>
<td>SpIn All</td>
<td>S/PDIF (RCA) Inputs to all Analog Output pairs.</td>
</tr>
<tr>
<td>SpOt 1/2</td>
<td>Analog Inputs 1–2 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt 5/6</td>
<td>Analog Inputs 5–6 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt 7/8</td>
<td>Analog Inputs 7–8 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt All</td>
<td>All Analog input pairs to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpAg</td>
<td>Simultaneous routing of S/PDIF (RCA) Inputs to Analog Outputs 1–2 and Analog Inputs 1–2 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>Adat</td>
<td>Simultaneous routing of ADAT Optical Inputs to Analog Outputs 1–8 and Analog Inputs 1–8 to ADAT Optical Outputs.</td>
</tr>
</tbody>
</table>
Appendix D: Hard Drive Configuration and Maintenance

It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

⚠️ Always back up any important data on your drive before formatting it, as it will erase all data on the drive.

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts or fewer plug-ins.

Supported Drive Formats and Drive Types

Drive Formats

Windows
Windows XP systems should use drives formatted as NTFS or FAT32 (NTFS preferred).

Mac
Mac systems should use drives formatted with HFS+ or HFS file system only.

Windows systems can also support Mac drives formatted with HFS+ system (also commonly referred to as Mac OS Extended). See the Pro Tools Reference Guide for more information.

Mac
Mac systems should use drives formatted with HFS+ or HFS file system only.

⚠️ HFS drives are supported as Transfer drives only.

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, see the Digidesign website (www.digidesign.com).
**SCSI Hard Drives**

Digidesign recommends qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

For complete information on track count and the supported number and configuration of SCSI drives, visit the Digidesign website (www.digidesign.com).

**FireWire Hard Drives**

Digidesign recommends qualified FireWire drives and (on Windows systems) a qualified FireWire host adapter.

For complete information on track count and the supported number and configuration of FireWire drives, visit the Digidesign website (www.digidesign.com).

**IDE/ATA/SATA Hard Drives**

A qualified internal IDE/ATA/SATA drive may be used as a dedicated audio drive.

For complete information on track count with internal drives, see the Digidesign website (www.digidesign.com).

---

**Formatting an Audio Drive**

**Formatting Windows Audio Drives**

(Windows Only)

For optimal performance, audio drives should be formatted as FAT32 or NTFS.

**To format an audio drive:**

1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Management.
3 If the volume is “Healthy,” do the following:

- Healthy volumes are volumes that have previously been partitioned and formatted.
- In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
- In the Format window, name the volume.
- Choose a file system. For optimum performance, audio drives should be formatted as NTFS. (FAT32 is also supported.)
- Select “Perform a quick format.”
- Make sure “Enable file and folder compression” is not selected.
- Set the Allocation unit size to Default.
- Click OK.

⚠️ Windows Disk Management can only create FAT32 volumes 32 GB or smaller. To create FAT32 volumes greater than 32 GB (up to 2 TB), use a third part utility (such as Swiss Knife or Partition Magic).

⚠️ Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.

4 If the volume is “Unallocated,” do the following:

- In the Disk Management window, right-click the hard drive you will use for audio and choose New Partition.
- In the New Partition Wizard window, click Next.
- When prompted, select the partition type.
- Follow the on-screen instructions to select a partition size and other partition settings.
- When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS. (FAT32 is also supported.)
- Select “Perform a quick format.”
- Make sure “Enable file and folder compression” is not selected.
- Set the Allocation unit size to Default.
- Click OK.

⚠️ Digidesign recommends using Primary partitions, instead of Extended partitions.

⚠️ Windows Disk Management can only create FAT32 volumes 32 GB or smaller. To create FAT32 volumes greater than 32 GB (up to 2 TB), use a third part utility (such as Swiss Knife or Partition Magic).

⚠️ Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.
Formatting Mac Audio Drives
(Mac Only)

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

To format an audio drive:

1. Launch the Disk Utility application, located in Applications/Utilities.
2. Click the Erase tab.
3. Select the drive you want to initialize in the column on the left side of the window.
4. Choose the Mac OS Extended (Journaled) format.
5. Type a name for the new volume.
6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers.
7. Click Erase.

The drive appears on the Desktop with the new volume name.

Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS or FAT32 for Windows, HFS+ for Mac).

FAT32 drive partitions have a limit of 2 terabytes (2000 gigabytes), whereas NTFS drive partition sizes are almost limitless.

Windows XP allows drives formatted with the NTFS or FAT32 file systems to be seen as whole volumes. Single Pro Tools audio files cannot exceed 2048 MB in size.

Mac OS allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a disk utility that recognizes the 2 terabyte limit. Single Pro Tools audio files cannot exceed 2048 MB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.
Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontiguous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

💡 On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).

Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive’s directories prior to optimizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive (Windows):

1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Defragmenter.
3. In the Disk Defragmenter window, choose the drive you want to defragment
4. Click the Defragment button and follow the on-screen instructions.

When defragmenting is complete, close the Computer Management Window.
**Using Mac Drives on Windows Systems**

Pro Tools for Windows lets you record and play back sessions directly from a Mac-formatted (HFS+) drive connected to a Windows system. This functionality requires that all Mac session and audio files be stored on Mac-formatted drives.

During Pro Tools installation, make sure to select the Mac HFS+ Disk Support option. This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks.

*For information on using the Mac HFS+ Disk Support option, see the HFS+ Disk Support Option Guide.*

*For information on sharing sessions between Mac and Windows systems, see the Pro Tools Reference Guide.*

**Formatting and Maintaining HFS+ Drives**

To format and partition any drives as HFS+, connect the drives to a Mac computer and use the Apple OS X Disk Utility.
Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.

Table 5 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

Table 5. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of tracks and length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
Table 6. Required hard drive space for audio tracks (88.2 kHz and 96 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of tracks and length</th>
<th>16-bit at 88.2 kHz</th>
<th>16-bit at 96 kHz</th>
<th>24-bit at 88.2 kHz</th>
<th>24-bit at 96 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>10 MB</td>
<td>11 MB</td>
<td>15 MB</td>
<td>16.4 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>100 MB</td>
<td>110 MB</td>
<td>150 MB</td>
<td>166 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>1200 MB</td>
<td>1324 MB</td>
<td>1800 MB</td>
<td>1982 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>1200 MB</td>
<td>1324 MB</td>
<td>1800 MB</td>
<td>1982 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>14 GB</td>
<td>15.6 GB</td>
<td>21 GB</td>
<td>23.2 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>1600 MB</td>
<td>1766 MB</td>
<td>2.4 GB</td>
<td>2.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>18.8 GB</td>
<td>20.8 GB</td>
<td>28 GB</td>
<td>30.8 GB</td>
</tr>
</tbody>
</table>
Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, including additional hard drives, automated tape backup systems, high-capacity optical drives, or CD/DVD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 You can also use the Auto Save Backup feature (in the Operation Preferences page) to have Pro Tools automatically save backups of the session file while you work.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Common Issues

Pro Tools Won’t Launch

Problem

When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn’t launch, or displays an error message.

Possible Solutions

🔹 Check to be sure your computer has the required amount of RAM to launch Pro Tools. See the Digidesign website (www.digidesign.com).
🔹 Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:

- Close any error message.
- Double-click the Pro Tools application.
- In Pro Tools, choose File > Open Session to open the session.
- Reinstall the Pro Tools application, using the Pro Tools Installer disc.

**Audio Interface Is Not Recognized**

**Problem**

When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

**Possible Solutions**

- Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.

**Performance Factors**

There are several conditions that may adversely affect the performance of Pro Tools. These include:

**Network Connections** Close any network connections unless you are using them for network interchange of audio data.

**Background Applications** Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

**Screen Savers** Screen saver software should be completely disabled on your computer before running Pro Tools.

**Power Saver Features** Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.

---

**Before You Call Digidesign Technical Support**

**Register Your System**

Register your purchase immediately after reviewing the Digidesign Registration Information Card included with every Pro Tools system. Registering your purchase is the only way you become eligible to receive complimentary technical support and future upgrade offers. Registering is one of the most important steps to complete as a new user.

**Use Digidesign Resources**

In addition to the printed and PDF versions of Pro Tools guides, your system includes the following sources of information:

**Read Me Files** These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in the Documentation folder when you install Pro Tools.

**Answerbase** This is a database of common problems and DAE errors, and their solutions based on the latest information from Digidesign Technical Support. This database is installed in the Digidesign folder when you install Pro Tools. Answerbase is also available on the Digidesign website (www.digidesign.com).

**Website (www.digidesign.com)** This is your best online source for information to help you get the most out of your Pro Tools system.
Gather Important Information

Digidesign wants to help you resolve problems as quickly and efficiently as possible. If you have the following information handy when you contact Technical Support, it will make the diagnosis of your problem easier. Take a few minutes to collect the following basic information:

System Information

Computer
- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

Digidesign Hardware
- Type of cards, interfaces, or peripherals

Hard Drives
- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

Digidesign Software
- Pro Tools software version
- Plug-in versions
- Other Digidesign software
- Additional plug-ins from Digidesign Development Partners

Other Hardware

See the manufacturer’s documentation for operational details.

The most common hardware additions include:
- 1394 (FireWire) cards (manufacturer, model)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, visit the Digidesign website (www.digidesign.com).

Other Software

If you are using other audio or video applications, see the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.

Diagnostic Information

Note any DAE errors or other error codes you encounter. Additionally, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Numerics
003
1394 LED 35
connecting (Mac) 21
connecting (Windows) 12
Display section 34
Fader section 36
features 3, 4
Headphone jacks 50
LCD display 34
Monitor section 50
package 3
Power switch 60
Pro Tools mode 83
top panel 33
top panel shortcuts 101
Transport section 44
window show/hide switches 46
003 Rack
1394 LED 53
connecting (Mac) 21
connecting (Windows) 12
features 3
front panel 51
Headphone jacks 51
Monitor section 52
package 3
Power switch 51
1394
LED (003 Rack) 53
LED (003) 35
port 59
3/4-HP2 switch
003 50
003 Rack 52
4-pin FireWire cable (Windows) 13

A
AC power connector 60
ADAT
connecting 68, 72
LED (003 Rack) 53
LED (003) 35
Optical I/O 58
additional software
Mac 19
Windows 15
Alt CR switch
003 50
003 Rack 53
Alt Monitor Outputs 57
Analog Inputs 5–8 57
analog tape deck, connecting 72
Arrow keys 45
ASIO driver (Windows) 15
Assign mode 92
assigning
inputs and outputs 92
inserts 94
sends 93
audio
connecting inputs 63
playback 77
playing 77
recording 75
audio drivers
ASIO driver (Windows) 15
CoreAudio driver (Mac) 20
WaveDriver (Windows) 16
Audio MIDI Setup (AMS) (Mac) 109
Audio tests 117
authorizing Pro Tools 24
Auto (Automation) Channel Meter LED 39
Automation modes
setting 100
switch LEDs 48
switches 48
Aux In (to Monitor) switch
003 50
003 Rack 53
Aux In to 7/8 switch
003 50
003 Rack 52
Aux Ins 58

B
Bank switch 46
banking
Master Faders 100
banking channels
eight channels at a time 99
one channels at a time 99
scrolling 99
bouncing audio to disk 78
burning a CD 79
bypassing
all plug-ins 89
single plug-in 86, 88

C
cables, microphone 63
cancel 43
channel controls
Channel Select switches 37
faders 36
Mute switch 37
Rec Arm switch 39
rotary encoders 38
Solo switch 37
Channel Meter LEDs 38, 39
Auto (Automation) 39
Left 39
Right 39
Channel Select switches 37
Channel View 87
switches 42
Clean Uninstall (Mac) 22
ClearType font smoothing (Windows), disabling 10
Clock Source 28
compatibility information 5

creating
ADAT 68, 72
analog tape deck 72
audio inputs 63
digital devices 67, 72
external effects devices 69
guitars 66
headphones 61
instruments 65
keyboards 66
microphones 63
microphones (1/4-inch connector) 65
microphones (XLR connector) 64
MIDI devices 72
mixdown recorder 72
mixers 66
S/PDIF Optical devices 68
S/PDIF RCA devices 68
connecting a sound system 61
Console View 84, 87
switches 41
CoreAudio driver (Mac) 20
Standalone driver 20
CPU Usage Limit 26

cursor
moving one frame at a time 97
moving up or down one track 97

cycling
Dynamics plug-ins 88
EQ plug-ins 87
inserts 88

D
DAE Playback Buffer Size 27
Dashboard shortcut (Mac), disabling 18
DAT recorder, connecting 72
default settings 97
Default switch 40
DI Inputs 1–4 56
digital devices, connecting 67, 72
Direct Inject inputs 56
Direct Interface inputs 56
Display Mode switch 35
Index

133

Display section 34
Display switches 46

displaying
  channel pan setting and send levels temporarily 91
  Dynamics plug-in controls 88
  Dynamics plug-ins on a track 87
  EQ plug-in controls 88
  EQ plug-ins on a track 87
  fader level temporarily 90
  full names of insert parameters 90
  full names of tracks 90
  insert settings temporarily 91
  inserts on a track 88
  Memory Locations 98
  plug-in controls 86, 88
  plug-in settings temporarily 91
  sends on a track 89
  settings instead of control names 90
  settings instead of track names 90
DMA option (Windows), enabling 9

drive
  Mac formatting 122
  requirements 6
  Windows formatting 120

drive formatting
  Mac 122

drive maintenance 119

Dynamics plug-ins
  cycling through 88
  displaying all on a track 87
  displaying controls 88

Dynamics switch 42

E

Edit selection
  during playback 97
  extending up or down a track 97
  moving up or down one track 97

Edit switch 46

Edit window
  Edit window
    zooming 96
    scrolling 97

Energy Saver (Mac), turning off 18
Enter switch 47
entry fields, navigating 91

EQ
  in Channel View 87
  EQ plug-ins
    cycling through 87
    displaying all on a track 87
    displaying controls 87
  EQ switch 42
ESC switch 43
external effects devices, using 69

F
  F1 Utility 113
  Fader Flip switch 40
  Fader Group test 116
  Fader Mute switch 47
  Fader section 36
  faders 36
    Flip mode 98
    testing and resetting 115
Fast Forward 44
FW 44
FireWire
  4-pin cable (Windows) 13
  connecting drives 60
  connecting drives (Mac) 21, 22
  connecting drives (Windows) 13
  connecting other devices 60
  connecting other devices (Mac) 22
  connecting other devices (Windows) 14
  connection status (003 Rack) 53
  connection status (003) 35
  port 59
  requirements 120
firmware 114
Flip mode 98
views 98
Focus switch 47
footswitch 59

G
  guide conventions 7
  guitar, connecting 66
hard drives
   drive formats 119
   FireWire 60
   FireWire (Mac) 21, 22
   FireWire (Windows) 13
   FireWire requirements 120
   formatting (Mac) 122
   formatting (Windows) 120
   IDE/ATA requirements 120
   maintenance 119, 123
   optimizing 123
   partitioning 122
   requirements 6
   SCSI requirements 120
   space requirements 125

Hardware Buffer Size 25
Hardware Setup dialog 28
headphone
   jacks (003 Rack) 51
headphones
   connecting 61
   jacks (003) 50
   Level controls (003 Rack) 52
   Level controls (003) 50
headroom 55
high pass filter switches
   003 49
   003 Rack 52
Host status LED 35, 53
HPF switches
   003 49
   003 Rack 52
Hyper-Threading (Windows), disabling 11

I/O Setup 30
IDE/ATA requirements 120
IEEE-1394
   port 59
importing audio from a CD 77
Input 1–4 Gain controls
   003 49
   003 Rack 52
Input switch 40

inputs
   Analog Inputs 5–8 57
   assigning 92
   Aux In 58
   controls (003 Rack) 52
   controls (003) 49
   DI Inputs 1–4 56
   Mic Inputs 1–4 56
   MIDI 59
   Optical 58
   S/PDIF 58
Insert switch
   Channel View 43
   Console View 42
Insert View (Console View) 86
Insert/Send Position switches 41
inserts 43
   assigning 94
   bypassing a plug-in 86
   cycling through 88
   displaying an Insert position 86
   displaying inserts on a track 88
   displaying plug-in controls 86
   in Channel View 43
   working with 86
installing
   optional items (Mac) 19
   optional items (Windows) 14
   Pro Tools (Mac) 19
   Pro Tools (Windows) 14
   QuickTime (Windows) 15
Instrument tracks
   creating 80
   recording to 82
instruments
   connecting 65

Jog mode 45
Jog/Shuttle wheel 45
   Jog mode 45
   Shuttle mode 45
journaling (Mac), enabling 19

Kensington Lock port 59
key commands 7
keyboards
  connecting 66
knobs (see rotary encoders)

L
Latch Automation
  LED 48
    switch 48
launching Pro Tools 24
LCD
  display 34
    test 114
LEDs
  Automation modes 48
    test 114
Left Channel Meter LED 39
Lightpipe 59
Link indicator 60
Loop Play switch 46
Loop Rec switch 46

M
Main Analog Outputs 1–8 57
Main Monitor Outputs 57
Master Faders 40
Mem Loc switch 46
Memory Locations
  creating 98
  displaying 98
  recalling 98
  switch 46
  working with 98
Meter switch 39
meters
  channel LEDs 38
Mic Inputs 1–4 56
Mic/DI
  controls (003 Rack) 52
    controls (003) 49
  switches (003 Rack) 52
    switches (003) 49
microphones
  1/4-inch connectors 65
    cables 63
    connecting 63
    inputs 56
    phantom power 64
    XLR connectors 64
MIDI
  connections 72
    defined 80
    monitoring 73
    playback 82
    requirements 5
    setup (Mac) 109
    setup (Windows) 105
    test 117
MIDI Data LEDs
  003 35, 53
MIDI Edit switch 47
MIDI In 59
MIDI Input selector 80
MIDI Map switches 47
MIDI mode 32
MIDI Out 1 59
MIDI Out 2 59
MIDI Recall switch 47
MIDI Studio Setup (MSS) (Windows) 105
mirroring outputs 62
Mix switch 46
mixdown and connecting a recorder 72
mixers
  connecting 66
modes
  Flip mode 40
  MIDI mode 32
  Pro Tools mode 31
  Standby mode 31
  Third Party Software mode 32
  Utility mode 32, 113
modifier keys 49
  Command 48
  Control 48
  Option 48
  Shift 48
Monitor Level control
  003 50
  003 Rack 52
Monitor Mute switch
003 50
003 Rack 53
Monitor section
003 50
003 Rack 52
monitoring
MIDI instruments 73
Mono switch
003 50
003 Rack 53
Mstr Faders switch 40
Mute switch 37
muting fader movement 100

N
navigating 96
network cards (Windows), disabling 11
network connections 128
New Tracks dialog 91
Nudge switch 46

O
Off
Automation LED 48
Automation switch 48
OK switch 47
Operating Level switches 57
operating levels 55
Optical format 29
Optical I/O 58
optimizing hard drives 123
Output windows 95
outputs
Alt Monitor 57
assigning 92
digital 58
Main Analog Outputs 1–8 57
Main Monitor 57
MIDI 59
mirroring 62
Optical 58
S/PDIF 58

P
Page switches 43
Pan switches 41
Pan View 84
Pan/Send Flip mode 99
Pan/Send switch 43
panning
adjusting on a track that has sends 89
panning a track 84
partitioning hard drives 122
phantom power 64
when to use 64
Phantom Power switches 56
Play 44
playing
backwards at a variable rate 96
forwards at a variable rate 96
imported audio 77
recorded audio track 77
recorded MIDI data 82
Plug-In Flip mode 99
Plug-In Master Bypass switch 43
Plug-in switch 46
plug-ins
bypassing all 89
bypassing one 88
displaying controls 86, 88
toggling views 47
power 60
management settings (Windows) 10
Power switch
003 60
003 Rack 51
Pro Tools
as Word clock master 68
as Word clock slave 69
authorizing 24
bouncing audio to disk 78
common tasks 75
creating an audio CD 78
demo session (Mac) 20
demo session (Windows) 16
guides 6
hardware settings 28
importing audio for a CD 77
installing (Mac) 19
installing (Windows) 14
launching 24
LE capabilities 5
recording a session 75
recording MIDI 80
removing (Mac) 22
removing (Windows) 16
setting defaults 97
Pro Tools mode 83
adding comments 92
Assign mode 92
assigning inputs and outputs 92
assigning inserts 94
assigning sends 93
automation 100
banking channels 99
banking Master Fader tracks 100
Channel View 87
Console View 84, 87
display options 90
editing entry field values 91
enabling 83
Flip mode 98
Insert View workflows (Console View) 86
Memory Locations 98
muting fader movement 100
naming tracks 92
navigating Edit window 96
navigating entry fields 91
navigating New Tracks dialog 91
Output windows 95
overview 31
Pan View workflows 84
record enabling tracks 96
renaming tracks 85
saving a session 83
Send View workflows 85
shortcuts 101
Undo operations 97
processor performance (Mac) 18
Processor Scheduling performance (Windows) 11
Program Change dialog 108, 112
QuickPunch switch 46
QuickStart installation 1
QuickTime installation (Windows) 15
Read Automation
LED 48
switch 48
Rec Arm switch 39
recalling a Memory Location 98
Record 44
recording
a session 75
audio 75
disabling tracks 96
enabling tracks 96
MIDI 80
preparing an audio track 76
registration information 6
removing Pro Tools
Mac 22
Windows 16
renaming a track 85
Return to Zero 44
REW 44
Rewind 44
Right Channel Meter LED 39
rotary encoders 38
Flip mode 98
LEDs 38
test
RTAS Engine 26
RTAS Processors setting 25
RTZ 44
S/PDIF
connecting Optical devices 68
connecting RCA devices 68
input and output ports 58
LED (003 Rack) 53
LED (003) 35
Safe Uninstall (Mac) 22
sample rate 55
default 28
Save switch 47
saving a session (003) 83
screen savers 128
scrolling the Edit window 97
SCSI requirements 120
selecting
  a range of tracks 84
  a track 84
  all tracks 85
  noncontiguous tracks 85

Send Flip mode 98
Send switch 42
Send View 85

sends
  adjusting send level 85, 89
  assigning 93
  displaying a Send position 85
  displaying sends on a track 89
  toggling pre- and post-fader 86, 90
  viewing level 91
  working with 85

session, creating 75
Shuttle mode 45
Software Update (Mac), turning off 18
Solo switch 37
sound system
  connecting 61
Spotlight indexing (Mac), disabling 18
Spotlight shortcuts (Mac), disabling 18
Standby mode 31
starting Pro Tools 24
Startup items (Windows), disabling 12
Stop 44
Suspend switch 48
suspending automation 100

switches
  3/4-HP 2 (003 Rack) 52
  3/4-HP 2 (003) 50
  Alt CR (003 Rack) 53
  Alt CR (003) 50
  Automation modes 48
  Aux In (to Monitor) (003 Rack) 53
  Aux In (to Monitor) (003) 50
  Aux In to 7/8 (003 Rack) 52
  Aux In to 7/8 (003) 50
  Bank switch 46
  Channel View 42
  Console View 41
  Default 40
  Display Mode 35
  Dynamics 42
  Edit window 46

Enter 47
EQ 42
ESC 43
Fader Flip 40
Fader Mute 47
Focus 47
HPF (003 Rack) 52
HPF (003) 49
Input 40
Insert (Channel View) 43
Insert (Console View) 42
Insert/Send Position 41
Loop Play 46
Loop Rec 46
Mem Loc 46
Mic/DI (003 Rack) 52
Mic/DI (003) 49
MIDI Edit 47
MIDI Map 47
MIDI Recall 47
Mix window 46
Monitor Mute (003 Rack) 53
Monitor Mute (003) 50
Mono (003 Rack) 53
Mono (003) 50
Nudge switch 46
Operating Level 57
Page 43
Pan 41
Pan/Send 43
Phantom Power 56
Plug-in Master Bypass 43
Plug-in window 46
QuickPunch 46
Save 47
Send 42
Suspend 48
testing 115
Undo 47
Utility 47
Zoom switch 46

SYNC LEDs
  003 35
  003 Rack 53
system optimization (Mac) 17
optional optimizations (Windows) 11
recommended optimizations (Windows) 10
required optimizations (Windows) 9
shutting down 23
starting up 23
system optimization
Windows 11
system requirements 5
system settings
Clock Source 28
configuring 24
CPU Usage Limit 26
DAE Playback Buffer Size 27
Hardware Buffer Size 25
I/O Setup 30
Optical format 29
RTAS Engine 26
RTAS Processors 25
Sample Rate 28

T
testing
audio connections 117
faders 115
LCD 114
LEDs 114
MIDI connections 117
rotary encoders 115
switches 115
Third Party Software mode 32
toggling plug-in views 47
Touch Automation
LED 48
switch 48
Touch test 116
tracks
adding comments 92
decreasing number of 91
increasing number of 91
naming 92
navigating New Tracks dialog 91
renaming 85
selecting 84
selecting a range 84
selecting all 85
selecting noncontiguous tracks 85

Transport
moving one frame at a time 97

U
Undo operations 97
Undo switch 47
uninstalling Pro Tools
Mac 22
Windows 16
Utility mode 32, 113
accessing 113
Audio tests 117
automated Fader tests 115
Encoder test
exiting 113
Fader Group test 116
Fader tests 115
firmware version 114
LCD test 114
LED test 114
MIDI test 117
navigating 113
Switch test 115
Touch test 116
Vegas mode 116
Utility switch 47

V
Vegas mode 116

W
W Clik LED
003 35
003 Rack 53
WaveDriver (Windows) 16
window show/hide switches 46
Word Clock
In and Out ports 59
LED (003 Rack) 53
LED (003) 35
Pro Tools as master 68
Pro Tools as slave 69
working
  in Channel View 87
  in Console View 84, 87
  in Insert View (Console View) 86
  in Pan View 84
  in Send View 85
Write Automation
  LED 48
  switch 48

Z
Zoom switch 46
zooming 96